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Introduction to the User Guide

This user guide gives instructions on using the Centralized Reporting System for the following:

e Accessing summative assessment data.
e Accessing interim assessment data.
e Scoring interim assessments.

It includes the following sections:

e Navigate Reports

e Set Up Reports to Suit Your Needs

e Export and Print Data

e Score ltems

Login Process

This section describes how to log in to the Centralized Reporting System.

Do not share your login information with anyone. All HSAP systems provide access to student
information, which must be protected in accordance with federal privacy laws.

Logging In to the Centralized Reporting System
1. Navigate to the HSAP portal at alohahsap.org and select your assessment program.

2. Select your user role from the cards displayed (see Figure 1).
3. Under the After Testing section, click the Centralized Reporting System card.

Figure 1. User Role Centralized Reporting System & Cards

SYSTEM

-8,

CRS (Centralized Reporting

System)
Test Coordinators and
Teachers i e e Al Access and download state
Access systems used before, assessment results and view

i ) Access systems used before,
during and after testing and y

review key resources.

during and after testing and reports on student performance.
review key resources
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4. Onthe Login Page (see Figure 2), enter the email address and password you use to access all HSAP

systems.
Figure 2. Login Page Figure

Please Leg In

Enter your usemame and password to log into GAl online
systems. Once you log in, you will automatically be directed to

B Email Address
your selected system.

?
Need More Help? m Password

If you forgot your password or need a new password, please

use the Forgot Your Password link to reset it Forgot Your Password?

First Time Login This School
Year?

Login emails for all HIDOE users, except
Charter Schools, have been updated fo the
new email format: EmployeelD#@k12 hi.us
The passwords you used during the previous
school year has expired.

For assistance, contact the Help Desk at

1-866-648-3712 | com

Request a new one for this school year.

a. Click Secure Login.

Figure 3. Enter Code Page

Enter Code

] A code has been sent to your email address. The code
will expire after 15 minutes.

B Enter Emailed Code

Resend Code

Cancel

b. If the Enter Code page appears, an authentication code is automatically sent to your
email address. You must enter this code in the Enter Emailed Code field and click Submit

within 15 minutes.

If the authentication code has expired, click Resend Code to request a new code.

c. If your account is associated with multiple institutions, you are prompted to select a
role, as in Figure 4. From the Role drop-down list, select the role and institution
combination you wish to use. You can also change your institution after logging in.

Figure 4. Select Role Window

) §

User Role: | - Select -

Administration Details

Select the User Role, Test Administration, District, and School (as applicable)

Test Coordinator (TC)
Test Administrator (TA) [}r

Y ’

The dashboard for your user role appears.

Note: For Hawai’i, any references to “district-level users” represents HIDOE users who are in the
TIDE system with the Complex user role. Please see the TIDE User Guide on the alohsahsap.org
portal page for additional information about user roles.

4
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Set or Reset Your Password

Your username is the email address associated with your account in Test Information Distribution Engine
(TIDE). If you are a user who was recently added to TIDE, you should receive an email from
DoNotReply@cambiumast.com that contains a link to the Reset Your Password page (see Figure 5). To
activate your account, you must set your password within 15 minutes.

All users are required to do a one-time password reset at the beginning of every school year, for security
purposes.

o If your first temporary link expired:

In the activation email you received, click the second link provided and request a new temporary
link.

e If you forgot your password:

On the Login page, click Forgot Your Password? and enter your email address in the E-mail
Address field. Click Submit. You will receive an email with a new temporary link to reset your
password.

Figure 5. Reset Your Password Page

Reset Your Password

Reset Your Password

Enter your email address and select Submit. You will receive an
email that contains alink to create a new password. E-m a|| Ad d ress
Need More Help?

If you forgot your password or need a new password, please “

use the Forgot Your Password link to reset it.

Return to Login Page
For assistance, contact the Help Desk at
1-866-648-3712 | heaphelpdesk@cambiumassessment.com

e If you did not receive an email containing a temporary link or authentication code:

Check your spam folder to make sure your email program did not categorize it as junk mail. If
you still do not see an email, contact your School Test Coordinator to make sure you are listed in
TIDE.

e If you did not receive an email containing a temporary link or authentication code:

Check your spam folder to make sure your email program did not categorize it as junk mail. If
you still do not see an email, contact your School Test Coordinator to make sure you are listed in
TIDE.

e Additional help:

If you are unable to log in, contact the HSAP Help Desk for assistance. You must provide your
name and email address. Contact information is available in the User Support section of this
user guide.
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Navigate Reports

This section explains how to navigate your reports for your assessments.

Understand Which Students Appear in Your Reports

e Teachers can view data for all students in their classes (rosters) who have completed assessments.
They can also view data for students to whom they have administered assessments in the current
school year.

e School-level users can view data for all students in their schools who have completed assessments.

e Complex-level users can view data for all students in their complex who have completed
assessments.

Note: Any reference you may see to “district-level users” refers to HIDOE users who are in the TIDE
system with the Complex user role. Please see the TIDE User Guide on the alohsahsap.org portal
page for additional information about user roles.

Start Viewing Reports

Use the Dashboard Generator Page

When you log in to the Centralized Reporting System, the Dashboard Generator page appears (Figure 6).
The controls on the left let you select from the groups of tests that have been processed in your state
for the school year. Typically, you may choose test types, subjects within the test types, and grades
within the subjects.

Figure 6. Dashboard Generator Page

Hv @HAWAI'I Reportir Caseciriscoisr’ @Hew | DavoumscTa'v
Select Bols > Dashboard Generator
These are 2023-2024 school year reports. Change the reporting time period

Which test groups would you like to start with? Looking for a specific student? §EE Features & Tools

set the results of a student by entering ther
student 1D Reporting Options -

athematics Reborting T
m a Change Reporting Time
Period
A [ Formative

Download & Print A

@ Downioad Student
v (] Mathematics % Results

A () Checkpoint

Test Options PN

nterim
T 7o) Set Student Setting or
P p— @ Manoge Test Reason 7=), e View

To the right of the dashboard generation controls are some other useful features. The Looking for a
specific student? section allows you to use student ID to view all that student’s test results.
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The Features & Tools menu appears on the right side of this page and in reports and offers multiple
features that are described elsewhere in this guide. Dashboard features & tools will vary based on user

role.

If the Dashboard Generator shows a message saying there is no data, that means no test opportunities
are available for the selected school year.

1. Optional: To change the test groups listed in the Dashboard Generator, change the reporting time
period.

2. Select the tests you want to view, expanding the test groups as needed.

End Of Course Exams (EOC) — the EOC Exams for Algebra 1, Algebra 2, and Biology 1 (NGSS) are
designed to measure students’ levels of performance for the Common Core State Standards
(CCSS). Students enrolled in Algebra 1, Algebra 2, or Biology courses may be required by their
school to take the corresponding EOC Exam(s).

Formative — these are Formative Assessments created by Cambium Assessment, Inc. (CAl).
These tests are the pre-loaded Checkpoint assessments and are available for educators to
administer in the TA Live Site.

HSA-AIlt CEA — Hawai’i summative alternate assessments (HSA-Alt) in English Language Arts
(ELA), Mathematics and Science, and the HSA-Alt Classroom Embedded Assessments (CEAs) pilot
in ELA, Mathematics and Science offer an alternative assessment for qualified students. The
Hawai‘i Department of Education and Cambium Assessment, Inc. (CAl), developed online
alternate assessments that allow students to use computers or tablets to access the
assessments.

Interim — Fixed-Form Assessments that can be administered throughout the year to help
teachers monitor student progress. Because each student responds to the same test items,
teachers may more easily interpret their students’ performance on a common set of items.
Interim Assessments can provide educators with data to help them target instruction to meet
students’ individual learning needs. Students have up to five opportunities to take the IAB, FIAB
and ICAs throughout the school year.

o Science — the NGSS-aligned interim assessments (lAs) are designed to support teaching
and learning throughout the year. In addition, these assessments can be used to
prepare students for this year’s summative assessments.

o Interim Comprehensive Assessments (ICA) — the ICAs assess the same range of
standards as the summative assessments and provide scores on the same scale. ICAs are
simulations of the full-length summative assessments and address the same range of
standards as the current summative assessments.

o Interim Assessment Blocks (IAB) & Focused Interim Assessment Blocks (FIAB) — short
assessment blocks on smaller sets of Hawai‘i Common Core Standards that provide
more detailed target information within a claim for instructional purposes. Educators
can use IABs and FIABs during the school year more consistently with the sequence of
their instruction.
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e Smarter Summative Assessments — Smarter Balanced Assessments (SBAs) provide aggregate
data to schools to help inform school and program improvement goals. Summative assessment
results are also used as an accountability measure, at the end of the year to determine students’
progress toward college and career readiness in English language arts/literacy (ELA) and
mathematics.

e Field Authored — Field Authored tests are created in the content creation site known as the
Hawai’i Checkpoint system. Educators can create items that align to standards, and they can be
added to original tests. The tests created in Checkpoint (Authoring) can be published to the TA
Live Site, where they can be administered to students. When seeking the results of a teacher-
created checkpoint test, refer to the Field Authored Test Group. Checkpoint items and test
forms are to be used formatively, in other words, not for grading purposes and only for
instructional next steps.

3. Optional: To save your selections, mark the checkbox Make these my default selections. These
selections will be set in the Dashboard Generator whenever you log in. You can change the defaults
at any time.

4. Click Go to Dashboard. The dashboard appears, displaying any data available for your selections.

Use the Dashboard to View Aggregate Test Results

All users can view the standard dashboard. It displays an aggregation card representing test groups. A

typical test group comprises a single test type, a single subject, and all grades (for example, the first card
shown in Figure 7 is for Summative Mathematics).

Each aggregation card displays the test group name, a list of grades, the number of students who took
tests in the group, the date of the test last taken, and a performance distribution bar displaying both
percentages and student counts below it. You may sometimes receive the message “Data cannot be
aggregated together for this group of tests” instead of the performance distribution bar for tests that do
not report performance distribution, or that use different sets of performance levels. Test group cards
are sorted by date last taken.

Figure 7. Dashboard

#iv @HAWAI‘I Reporting C3 SecureFile Center @ Help ~ DemoUser, SC v

Select Role > Dashboard Generator > Dashboard Enter Student ID Q

-k
= Performance Distribution, By Test Group: Kula a'o Hawai'i, 2023-2024 ves
B i ek isscnn: RN ARG e ay DA TARTRNED 1% Features & Tools

E::-. N Interim Blocks (IAB) il N Interim C i (IcA) Reporting Options ~
Test Mathematics
Grous d Grades Tested: 3,4,5,6,7,8,11 “ ﬁ Change Reporting Time
TestsTaken:38  Date Last Taken: 09/21/2023 Grades Tested: 3, 4,5,6,7, 8,9, 10, 11 Period
= Tests Taken: 53 Date Last Taken: 09/21/2023 N
(=) @ b | Download & Print ~
b '///(!//A// o m i o .
Reasons - l Download Student
- o, Lol S pr
ot a4 & 4 percent
Coun Performance Levels Test Options A
. %Level 1 = [o=] Set Student Setting on
[Ey MensgeTestReasons  [#5] [EL VT
7| Interim Assessment Blocks (1AB) ELA [ tevei2
Roster Settings A
d Grades Tested:3,5,6,7,8,11 B stevel3
TestsTaken:37  Date Last Taken: 09/06/2023 I xeveis -+ Addroster @© viewsEdit Roster
evel
S S S S S S
]
w— e Tests Taken |_,T Upload Roster
Percent it 86% 1% 3%
t 82 4 "Tests Takel

Clicking the i button displays a legend with more information about performance levels.

8
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If a message appears saying “There are no assessments to display,” you may not have any students who
have taken tests in your selected test groups in the selected time period. You can change the reporting
time period. If you are a teacher, you may also be able to view more students’ data by managing your
classes (rosters).

To change the test groups and test reasons that appear, use the Filters panel on the left. For more
information on filtering, refer to Set Up Reports to Suit Your Needs. You can also backtrack to the
Dashboard Generator using the link in the path at the upper-left corner and change your test group
selections there.

View More Detailed Data on a Particular Test Group

To view more detailed data for a particular test group, click the name of the group. The Performance on
Tests report appears. It is filtered to display only the test group you selected.

In the Performance on Tests report, teachers view two tables, as in_Figure 8.
e The My Assessments table, listing all the assessments in the filtered test group or groups.

e The My Students table, listing all your students who took the assessments.

Figure 8. Teacher View: Performance on Tests Report

v EH

‘l | Reporting C3 Secure File Center @ Help | DemoUser, SC v

Select Role > Dashboard Generator > Dashboard > Performance on Tests nter Student Q
e

= A My Assessments i1t Features & Tools
Filters

Average Score and Performance Distribution, by Assessment: All Rosters, 2023-2024
tE; Fitered By Rosters: All Roster | Test Reasons: All Test Reasons |
w
T

Grops Assessment Name Test Group Test Grade Test Reason Student Count Average Score Performance Distribution Date Last Taken &
= Interim [}
'i=" &, | Grade 3 MATH - Geometry (FIAB) v Assessment 3 Opportunity 1 4 n/a Porcent  25%  25% 50% 09/21/2023
-8 Blocks (IAB) count 1 3
Reascn:
Rows per page: 10 1 ltems: 1 of1
Ré‘ A My Students
Most Recent Assessment of All Rosters: 2023-2024
Filtered By Rosters: All Roster | Test Reasons: All Test Reasons |
Student Name Student ID Most Recent Assessment DateTaken v
9999980283 Grade 3 MATH - Geometry (FIAB) 09/21/2023
9999980282 Grade 3 MATH - Geometry (FIAB) 09/21/2023
9999980293 Grade 3 MATH - Geometry (FIAB) 09/21/2023
9993002146 Grade 3 MATH - Geometry (FIAB) 09/21/2023
Rows per page: |10 4 items: 1 of1

Complex (District) and school-level users view just one table, as in Figure 9. Like the first table on the
teacher Performance on Tests report, this table lists all the assessments in the test group.

spuoday a1pBbIADN



Centralized Reporting System User Guide

Figure 9. Complex-Level User View: Performance on Tests Report

Select Role » Dashboard Generator > Dashboard > Performance on Tests Enter Student ID (e
-k
= o Average Score and Performance Distribution, by Assessment: Demo School Group 2, 2023-2024 132 Features & Tools
Filters Filtered By School: All Schools | Test Reasons:All Test Reasons
E——;—; Assessment Name Test Group Test Grade Test Reason Student Average Performance Distribution Date Last v
L, 8 Count Score Taken
Test
@
&,  Grade 3 MATH - Geometry (FIAB) A | Assessment 3 Qooorininy 5 o2 2 romET - 09/21/2023
= Blocks (IAB)
e
Eé Performance Levels
Test Interim
Reasons = -
State Grade 3 MATH - Geometry (FIAB) Assessment 3 - %Below Standard :
Blocks (IAB)
The student has not met the achievement standard
& Interim
Schools c‘;mplﬂ Grade 3 MATH - Geometry (FIAB) Assessment 3 :, %At/Near Standard : -
e Blocks (IAB) The student has nearly met the achievement standard
Interim D %Above Standard :

|, Grade 6 MATH - Performance
&<

Assessment 6 The student has met the achievement standard 08/24/2023
Task - Feeding the Giraffe (IAB)

Blocks (IAB)

Interim

.i, Grade 8 MATH - Expressions and v [ —"

Equations | (IAB) Unassigned 0 n/a n/a 08/04/2023

Interim

&, Grade3 MATH-Propertiesof Assessment 3 Fall 1 n/a

08/04/2023

Clicking the i) button displays a legend with more information about performance levels.

For each test, the assessments table shows the test group, grade, test reason (the name of the test
window of a summative assessment, or a category assigned to an interim assessment), number of
students who took the test, average score, performance distribution, and date the test was last taken.

You can use the filters to view a different set of assessments. For more information on filtering, refer to
Set Up Reports to Suit Your Needs.

If a message appears saying “There are no assessments to display” or “There are no students to display”,
you may have filtered out all data.

Teachers: View Student-Level Data for All Your Students

The Performance by Student tab of the My Students’ Performance on Test report displays test results
for each of your students across classes (rosters). In order to view the results for all your students,
follow the instructions below.

1. Generate a dashboard and click a test group name.

2. Click a test name in the assessments table at the top of the page. A page of test results appears.
3. Inthe My Students’ Performance on Test report that appears, select the Performance by Student

tab, as in Figure 10. The results that appear list all your students. The first few rows also show
aggregate performance data for your state, complex area, complex, school, and total students.
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Figure 10. Teacher View: My Students’ Performance on Test by Student Tab
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s
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e To see which students performed best,
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Sway |ew0) e

Performance
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1SI0M B} PaULIOHIad SIUBPNIS LDIYM U0 SWal & @

wa
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i :
P 208
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B T e
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click the score or Performance column header to sort

e You can view your students’ performance in each area of the test by clicking the reporting
category section bars to expand them, as shown in Figure 11. In the figure below, the categories
for a Math Interim CAT Assessment (ICA) include: 5 Items on which Students Performed the
Best, 5 Items on which Students Performed the Worst, Communicating Reasoning, Concepts and
Procedures, and Problem Solving and Modeling & Data Analysis.

o The row of numbers below the item point value indicates the average number of points earned
for that particular item (the column), in that particular group (the row). In Figure 11, you can see
that the average score for students within the school for item number 22 is .5 out of 1 point.

Figure 11. School Performance on Test by Student Tab with Expanded Reporting Category Section
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=
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R E |
ol : Y
£ £ 8 a
£ 1% sz
BN
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3 "
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Complex Ares 252346 @ pecemt = K i pecoe v £ 1 o
= : § oz B
[ o === o
Scnool 257346 @  pecen 00 o 50v o 1 s 05 1
demo. demo 9999344345 226037 @ Leve! At/Near Standard 0 [}
9999619892 2818425 @ Level 4 Above Standard 1 o 1 | 1
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School-Level Users: View Student-Level Data for All Your Students

You can follow the same procedure as in School-Level Users: View Student-Level Data for All Your
Students to view the Performance by Student tab of the School Performance on Test report.

View Test Results for Classes (Rosters) on a Particular Test

You can view a list of classes (rosters) that took a particular test, and you can also view the test results
for a particular class.

Access Test Results for All Your Classes (Rosters)

The Performance by Roster tab displays test results for each class (roster). To view this tab, follow the
instructions for your user role below.

Teachers and school-level users:

1.
2.

Generate a dashboard and click a test group name.
Click a test name in the table of assessments. Either the My Students’ Performance on Test or the

School Performance on Test report appears, depending on your role. It is open to the Performance
by Roster tab.

The report shown in Figure 12 displays a list of one teacher’s classes (rosters) and each rosters’
performance. The first few rows also show aggregate performance data for the state, complex area,
complex, school, and all their students.

Figure 12 Teacher View: My Students’ Performance on Test by Roster Tab

I Dashboard Generator >

Dashboard > Performance on Tests >

My Students' Performance on Test I

JPerformance by Rosterl Performan

et

Enter Student ID Q

i:: Features & Tools

2

Average Score, Performance Distributi rage Points Grade 5 Science - | AT Assessment (ICA) (Pre-Test), by
Roster and Reporting Category: 2023-20Z%F
Filtered By Rosters: All Roster | Test Reasons:Pre-Test
Roster N %) @@
g g c |3
@ .| & |2
o =32 %) L8
o o o
— KN -
Test 3| o
w Q
Stere Completion fverage Performance Distribution 2|®°|=
Count Scale Score 2 3
Rate 2 3
[%2)
Q
[
2
o
(]
State n/a n/a n/a
-]
[ e
Complex Area 3 46717 @ | percent o7 33
Count 2 1
=
1 N o
Complex 3 46717 @ | Percent 67% 1%
Count 2 1
=
°
School 3 46717 @ | Percent 7% 3%
Count 2 1
[ o
My Students 3 467+17 @ | Percent 6T% 3%
Count 2 1
K -]
] e
23-24 Reporting Demo Roster 3 33%(3/9) 467217 @ | Percent 67% 33%
Count 2 1
—
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Table 1. My Students’ Performance on Test Report: Performance by Roster Tab Elements

# Element

1 Class (Roster) Performance Data

2 Test Completion Rate Column (click to sort)
3 Scale Score Column (click to sort)

4 Performance Distribution Column (click to sort)

Complex-level users can view all classes (rosters) in a school. To do so, follow these instructions:
1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. A page of the complex test results appear, listing
schools within the complex.

3. Click a school name. The School Performance on Test report appears, open to the Performance by

Roster tab.

Figure 13. Complex-Level User View: School Performance by Roster Tab

I Select Role » Dashboard Generator > Dashboard > Performance on Tests » School Performance on Test I Ente
=+
=
=il l Performance by Rosterl Performance by

ent i} Features & Tools

[§) Average Score, Performance Distribution and Average Points Earned on Grade 3 MATH - Interim CAT Assessment (ICA) (Opportunity 1), by Roster and Reporting Category: Kula a'o Hawai’ 2023-2024

Sanceriz | Fiftered By Rosters: AllRoster | Test Reasons: Opportunity 1 | Standards Keys [l

Roster 4 Teacher Q (RN RERORN)
o ol @ 3
g 78|82
s 3 =l 3| 8 a
THLR
Student < Average . Percent = g o
i Completion # | ¢ A=E% Performanc Distribution Rizeby FoE § 3 £
Rate g g & » &
2 2 8|8 8
& 5|88 |=
203|238
5 %|8|° &
State n/a n/a n/a na 8 & a
: 5 :
[ ° i1 £
Complex Area 4 252326 @ |pecen T00% - 100% = 3 5
: 4 @ = =
2 g @
[ o -
Complex 4 252326 @ | pecen 1008 100%
Count 4
N ) o
School 4 252326 @ | percen e 100%
Count 4
(students not in any roster) 1 2518 @ | percent 100% 100%
oot B
2023-2024 Reporting UAT De... | Demolser, SC 3 33%(3/9) | 252429 @ | percen W/[/A ° 100%
Cout 8
Rows perpage: 10 2 tems: 1 of1

The report shown in Figure 13 displays a list of classes (rosters) and each class’s performance. The first
few rows also show aggregate performance data for your state, complex area, complex, school, and

students not in any roster.
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Determine Which Classes (Rosters) Performed Well on This Assessment
To find out which classes performed best on the test, do either of these things:
e Click the Average Scale Score column header to sort by score and look for rosters with high
average scores.
o Look at the bars in the Performance Distribution column to determine where the percentage of
students at or above proficient is high.
Determine Which Classes (Rosters) Had the Highest Test Completion Rates

To find out which classes had the highest test completion rate:

e Click the Test Completion Rate column header to sort the column (see Figure 12).

Determine How Well Classes (Rosters) Performed in Each Area on the Test

For tests with reporting category sections, you can compare the performance of your students in each
area of the test. Click each vertical section bar to expand or collapse it. In this example (Figure 14), you
can view average score and a performance distribution bar for each class (roster) under the reporting
category Earth and Space Science, Life Science, and Physical Science.

Figure 14. My Students’ Performance by Roster with Expanded Reporting Category Section

o Tetc >y Studets Tost P Q

zzz Foatures & Tools

werage Points Famed on Grade § Science - Interim CAT As

0170 R O] s X | = | @ | = * *
e I © x = ) = * *
. o

\..., T o

Interim comprehensive tests cover multiple reporting categories, while a benchmark test such
as a Checkpoint assessment or a Smarter IAB, covers only one.

View and Interpret Standard Measures Within Reporting Category Sections

Aggregate test results for adaptive tests may include detailed performance measures within standards
within reporting categories. Please note, the information in this section applies to all Hawai'i
assessments except for the Hawai’i Statewide Alternate Assessment (HSA-AIt), which only reports an
overall scale score.

For the Smarter Balanced Summative Assessment, an educational standard, sometimes called an
assessment target, describes at a more granular level than claim, the expectations of the knowledge,
skills, and/or abilities assessed by the items and tasks within each claim. Standards are nested within
clusters (groups of standards). A target can be aligned to one or more standards. For Smarter Balanced
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Summative Assessments, target reports are available for ELA/L claims 1 and 2, and Mathematics claim 1
only.

Note: 2023-2024For the Smarter Balanced ELA and Math assessments in Hawai’i, claim information
will be available at the individual student level for claim 1 for Math and claims 1 and 2 for ELA.
However, target reports are only available at the roster level for all reported claims for ELA but only in
claim 1 for Math. This user guide provides instructions and figures (examples) showing how to access
this information for SY 2023-2024 aggregates, and for all claims in past years’ Smarter Balanced
summative assessments at the student level, such as SY 2018-2019.

An educational standard or groups of standards, sometimes called an assessment target, describes the
skill the item measures. Standards are nested within clusters (groups of standards).

e The Standards sub-section (shown in Figure 15) contains the following:

= Clusters within the reporting category.
o Standards within each cluster.
= Measures within each standard, such as “Proficient” and “Weak or Strong?”
To learn more about each standard for a particular test, or the measures reported for each standard,

click the more information button o to the right of the standard name and/or the measure.

Figure 15. School Performance on Test: Performance by Roster Tab with Expanded Reporting Category Section

B v @HAWAI‘I Rep

Select Role > Dashboar

C3 secureFile Center @ Help | HIDOE, Demo PR v

1 Tests > School Performance on Test Enter § ) Q
-

e £
el Performance by Roster || Performance by Studer 1 1! Features & Tools

Average Score, Performance Distribution and Average Points Earned on Grade 5 Science - Interim CAT Assessment (ICA) (Pre-Te and Reporting Category: Kula ' Hawaii 2023-2024

Fikered By Rosters: AllRoster | Test Reasons:Pre-Test
Roster Teacher o‘? (x} Life e ®
B B 3
H =N B 2 Life Sclence | 3
4 23 H
il 2
< Performance B 152 @ l 152 @ 151 @ 3
; 8
& C . a| Weakor orio o @ Weakor 2 Weak or - Weak or
3 lFrmm-—m 0 vy @ Proficien? @ oo @ Proficient? @ Loy @ Proficent? @ ¢ o'
3 m— S
State * * * * * * * *
Complex Area Too Few ltems Hents * - * * * * x —
Complex Too Few Items or Too Few Students * = * * * * x —
School Too Few tems or Too Few Students * = * * * * x —
23-24 Reporting Demo Rostes Demo, Teacher Name Too Few Items or Too Few Students * ] * * * * X —
—

Table 2. Reporting Category Section Elements

# Element

1 Cluster header within a reporting category

2 Standard header within the cluster column

3 Performance measures within the standard

4 Additional reporting category section (not expanded)
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Each standard column consists of sub-columns displaying performance measures:

o “Proficient?”: This column displays icons indicating whether students have on average
attained proficiency in the standard (see Figure 16).

e  “Weak or Strong?”: You may want to identify strengths and weaknesses in different
standards within the reporting category so you can focus instruction on very specific areas
where improvement is needed. This column displays icons indicating how students’ average
performance on the standard compares with their average performance on the overall test.
Note that these icons indicate only relative performance and not proficiency.

To learn more about these performance measures, click the more info button i) (see Figure 16).

Figure 16. Legend 0 for the Proficient? and Weak or Strong? Columns

Proficient Weak or - Weak o
i Strong? © Froficient? @ Strong’ bid

Proficient? Weak or Strong?

/  Above the Proficiency Standard + Area of Strengths

Performance is similar to
At/Near Proficiency Standard === performance on the test as a

whole
=== Area of Weakness

x Below the Proficiency Standard

Insufficient Information % Insufficient Information

Additional information specifically for Smarter Balanced Summative Assessment target reports can also
be found in the Smarter Balanced Target Report Fact Sheet, available in the Reporting Resources section
on the AlohaHSAP.org portal.

Note: The most granular level of target reporting is at the roster level. A target report of a roster with
less than 10 students could be generated but may display insufficient information (*) for a majority of
the targets. Having at least 10 students in a roster is recommended to generate meaningful results,
although insufficient information (*) may still be displayed for some targets.

View and Interpret Writing Dimension Measures

Aggregate test results for some assessments may also include a Writing Dimensions section to the right
of the expandable sections in the report table. You can expand it by clicking the vertical bar, just as with
the reporting category sections. This section helps you understand how students performed on different
aspects of writing.

The Writing Dimensions section (Figure 17) contains the following under the Essay header:
e Essay type. For example, Informational, Narrative, and Opinion.

=  Writing dimension within the essay type, as listed in item rubrics. For example,
Conventions, Evidence/Elaboration, and Organization/Purpose.

— Point value. A sub-column for each possible item point value for the writing
dimension. Each point value sub-column displays the percentage of students who
earned that number of points.
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For each dimension, the lowest . and highest & point values are sometimes highlighted and marked
with arrow icons in the wors with the highest percentages. This allows you to quickly identify groups of
students who are performing well and those who may need additional support.

Note that highlighting and arrow icons do not appear when they are not useful. A report containing only
one row of data does not have them, and neither does a row in which the percentages are “n/a” or all
the same.

Figure 17. Complex Performance on Test Report with Expanded Writing Dimensions Section

Dashboard Selector 3 Dashboard Generator 3 Dashboard 3 P on Tests 3 District on Test

Average Score and Performance Distribution for Smarter Summative ELA/Literacy Grade 3 (Spring 20 immative)), by School and Reporting Gategory: Demo Complex 1, 2018-2019
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Table 3. Complex (District) Performance on Test Report Elements

# Element

Essay type header
Writing dimension header

1
2
3 Paint value
4 Cell with highest percentage earning highlighted

Figure 18. Complex Performance on Test with Expanded Writing Dimensions Legend

Dashooard : » Dashbosrd Generster » Dashboard 3 Tests » District Perform:

Demu Cemtes 1, 2018 2018

ferc By Bahosl: A Schoos. Tost Rewsans: Som 2013 {Smarter Surrmstve) 4
FE iB
Rilid —»
. - = . -
.
@, oottty
@ o o R o o n o "

To learn about the highlighting and arrow icons, click the more information © button in the Essay
header. A legend expands, as in Figure 18.
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Access Test Results for an Individual Class (Roster)

Prior sections explained how to access test results for all your classes (rosters). To view results for one
specific class (roster), click the name of a class that appears in the first column of the report. The class
results listed by student appear (Figure 19).

Figure 19. Teacher View: My Student’s Performance: Roster Performance on Test
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Determine How Well Students in Your Class (Roster) Performed in Each Area of the Test

You can compare the performance of your students in each area of the test using the reporting category
sections, as shown in Figure 20. Click each vertical section bar to expand or collapse it.

Figure 20. Teacher View: My Students’ Roster Performance with Expanded Reporting Category Sections

spu0day alpBIADN
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School- and Complex-Level Users: View Test Results for a School on a Particular
Test

You can view test results for all the students in a school on a particular test. This gives you a high-level
look at how the school is performing.

Access Test Results for a School
School-level users:
1. Generate a dashboard and click a test group name.

2. Click a test name in the table of My Assessments. My Students’ Performance on Test report
appears, with the school data shown.

Complex-level users:
1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. A table listing test results by State, Complex Area,
Complex and a list of schools appears.

3. Click the name of the school for which you would like to view results. The test results for the school
appear organized by roster.

Note that complex-level users can also access the test results from a school directly from the
Performance on Tests report, by first filtering by school. See the section Complex-Level Users: Filter
Schools to Display.

The Performance by Roster tab is open by default, as in Figure 21.

Figure 21. Complex-Level User: School Performance on Test Report: Performance by Roster Tab
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Determine Which Classes (Rosters) Performed Well on This Assessment

In the Performance by Roster tab, look at the Performance Distribution column and click the header of
the score column to sort by score (see Figure 21). Rosters with a high average scale score, and with a
high percentage of students performing at or above proficient in the performance distribution bar,
performed well on the assessment. If certain classes (rosters) performed consistently well, you could use
them as a model for the classes with lower performance.

Complex-Level Users: View Test Results for a Complex on a Particular Test

You can view test results for a complex on a particular test.

This gives you a high-level view of how the complex is performing.
Access Test Results for a Complex

1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. The Complex (District) Performance on Test report
appears, listing all schools in the complex (Figure 22).

Figure 22. District-Level User: Complex (District) Performance on Test Report
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Determine Which Schools in the Complex Performed Well on This Assessment

Look at the Average Scale Score column and/or Performance Distribution column and click to sort by it
(asin Figure 22).
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Determine How Well Schools in the Complex Performed in Each Area of the Test

Click the vertical section bars to expand the reporting category sections (as in Figure 23).

Figure 23. Complex (District) Performance on Test Report with Expanded Reporting Category Sections
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View Test Results Broken Down by Demographic Sub-Groups

v

Q

You can use the Breakdown By button in the Features & Tools menu to compare performance between
different demographic sub-groups. This button is available for most aggregate test results.

View Test Results Broken Down by Demographic Sub-Groups

To view test results broken down by demographic sub-groups, do the following:

1. Click Breakdown By in the Features & Tools menu. The Breakdown Attributes window opens.

Figure 24. Breakdown by: Breakdown Attributes Window
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Apply Cancel

2. Select up to three student demographic categories.
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There is also an Include unspecified values checkbox, explained below:

e Some students who complete tests do not have specific demographic information in the
Test Information Distribution Engine (TIDE). These students are considered to have
unspecified values.

e To include data for these students, mark the checkbox.

3. Click Apply.

e Data for each sub-group selected are displayed in the report, as in Figure 25.

Figure 25. Demographic Breakdown of a Complex (District) Performance on Test Report

P @HA Al'l | Reporting

Select Role > Dashboard Generator > Dashboard > Performance on Tests > District Performance on Test > Breakdown

Breakdown of Grade 3 Math (Spring 2023 (Smarter Summative)), by Disability, Ethnicity and Gender: Demo School Group 2, 2022-2023
Filtered By School: All Schools | Test Reasons: Spring 2023 (Smarter Summative)

St 0 _
g

View
Details

IeoL

4 : Student Average
Disability Ethnicity Gender iy Sl
All Al Al 3 2399477 @  percer
ith Disability | African American Female 1 2249 @  percem

Nith Disability | Two or More Races | Female 1 2444 @ pecenm

Count

Performance Distribution

RN o
T

C3 SecureFile Center @ Help DemoUser, SC v

Enter Student ID Q

i1 Features & Tools

Percent

»

3

5 g

g

3

Proficient a
H

3

Buoseay Bueownuiwo) @

67%

sishjeuy eteq 3 Buiop:

100%

Rows per page: 10 2ltems: 1 of1

Please see Table 4 for a list of the breakdown attributes and labels for the demographic sub-groups

available in CRS.

Table 4. Demographic Breakdown Attributes: Labels and Definitions

Category

Breakdown Attribute Label

Definition

Disability

01 — Autism

Autism

02 — Deaf-Blindness

Deaf-Blindness

03 — Deafness

Deafness

04 — Developmental Delay (Age 3-5)

Developmental Delay (Age 3-5)

05 — Developmental Delay (Age 6-8)

Developmental Delay (Age 6-8)

06 — Emotional Disturbance

Emotional Disturbance

07 — Hearing Impaired

Hearing Impaired

08 — Mental Retardation

Mental Retardation

09 — Multiple Disability

Multiple Disability

Disability (cont.)

10 — Orthopedic Impairment

Orthopedic Impairment

11 — Other Health Impairment

Other Health Impairment

12 — Specific Leaning Disability

Specific Learning Disability
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13 — Speech/Language Impairment

Speech/Language Impairment

14 — Traumatic Brain Injury

Traumatic Brain Injury

15 — Visual Impairment including
Blindness

Visual Impairment including Blindness

16 — Autism Spectrum Disorder

Autism Spectrum Disorder

17 — Other Health Disability

Other Health Disability

18 — Speech or Language Disability

Speech or Language Disability

19 — Intellectual Disability

Intellectual Disability

20 — Visual Disability Incl. Blindness

Visual Disability Incl. Blindness

21 — Hard of Hearing

Hard of Hearing

21 — Orthopedic Disability

Orthopedic Disability

Disadvantaged* 1 Free - Eligible
(Lunch Status -
TS:SQ?JSC?:% C Certified by the Hawaii Department of
9 Human Services
F Free
R Reduced
ELL No The student is not an English
Language Learner.
Yes The student is an English Language
Learner.
Enrolled Grade Grade 00 Home Schooled
Grade KG Kindergarten
Grade 01 Grade 1
Grade 02 Grade 2
Grade 03 Grade 3
Grade 04 Grade 4
Grade 05 Grade 5
Grade 06 Grade 6
Grade 07 Grade 7
Grade 08 Grade 8
Enrolled Grade Grade 09 Grade 9
(cont.)
Grade 10 Grade 10
Grade 11 Grade 11
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Grade 12 Grade 12
Grade 31 - 34 *Other
Ethnicity African American African American
American Indian/Alaskan Native American Indian/Alaskan Native
Asian/Pacific Islander Asian/Pacific Islander
Declined to Report Declined to Report
Hawaii Pacific Islander Hawaii Pacific Islander
Hispanic Hispanic
Multi-Racial Multi-Racial
White White
Gender Female Female
Male Male
Migrant Status No Student does not have migrant status.
Yes Student has migrant status.

*Please contact the Assessment Section if you have any questions about the demographic breakdown attributes.

View Test Results for a Particular Demographic Sub-Group or Combination

o When viewing test results broken down by sub-groups, go to the row for the demographic

!
combination you want to view and click the view button - in the View Details column on the
left (see Figure 25).

e A window opens, displaying detailed results for that combination. The report table is now laid
out the same way as the original report, before you viewed it broken down by sub-groups
(Figure 26).

Figure 26. Demographic Combination Breakdown Window (from School Performance on Test Report)

Breakdown of Grade 3 Math

Breakdown of Grade 3 Math (Spring 2023 (Smarter Summative)), by Disability: With Disability, Ethnicity: Two or More Races and Gender: Female: ‘ & Print
Demo School Group 2, 2022-2023
Fillered By School: All Schools | Test Reasons: Spring 2023 (Smarter Summative)

v Ethnicity Two or More Races v  Gender Female % -‘pp,,,,
senon S ——
=
g
L 3

Breakdown

by Disability With Disability

S2INPad0id pue 51daduo) @

2
3
2
o
2
8
Buoseay buneaunuALo) @

777z e

3 Bulapoy pue Buinos waigeid @

Kula a'o Hawai 1 2242 @ Parcont
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At the top of the report table are filter menus for each demographic category you chose. To change the
demographic combination displayed, use the filters to select the demographic sub-groups you want to
view and click Apply. The new combination is displayed.

You can use this window to get an in-depth look at specific groups of students. For example, you may
want to determine which classes (rosters) have the highest-performing girls in the first grade.

Track Student Performance Over Time

You can view your students’ performance over time across multiple related assessments or across
multiple test opportunities of a single assessment. This lets you understand how students’ performance
has improved or declined.

Each Longitudinal Report displays performance data for one of the following:
e A group of students who have completed every assessment available in the report.

o If you are a Complex- or School-level user, note that a certain percentage of students
must have taken all the related assessments in order for you to generate a Longitudinal
Report. Teachers have the option of adjusting the pool of students, tests, and test
reasons.

e Anindividual student who has completed the assessments (see Figure 27).

Figure 27. Longitudinal Report: Interim & Summative Report for an Individual Student

| Longitudinal Report

Longitudinal report of Score and Performance on Grade 3 Math: HIDOE Only, G3 Chidnas Salettions l [ =* Filters [ = l
Demo1, 2020-2022 x~ Change Selections 3£ Filters v &S Print

Test Reasons: All Test Reasons  School Year: All School Years  Reporting Date:

Overal Score Concepts and Procedures
A A

@ Smarter Summative @l A nterim Comprehensive Assessment (ICA)
r
Date Test Label Test Reason [}
=

g My Student's Score My Student's Performance

8/13/2020 Grade 4 MATH CAT (ICA) Unassigned 2198117 @ Level 1

sainpasald pue s1daouc) @

24424:22 @ Level 3

12/27/2022 Grade 3 Math
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Access a Longitudinal Report Comparing Related Assessments

If the student(s) in your test results have completed multiple related assessments, the Build
Longitudinal Report button allows you to access a Longitudinal Report in the reports for any of those
assessments. If they haven’t done so, then no Longitudinal Report is available. Some examples of
situations where no Longitudinal Report is available include Grade 3 students who are completing
interim testing for the first time, and students who are taking a different set of Interim Assessment
Blocks (IABs) in the current school year compared to prior school year.

Click the Build Longitudinal Report button in the Features & Tools menu (see Figure 28).

e The Longitudinal Report window appears. Depending on your role, the test types, and the
number of students in the report, it may display a report options page rather than the
Longitudinal Report itself. The contents of this page depend on your role and the number of
students.

e If you are viewing a Longitudinal Report for which both interims and summatives are available,
the Progression drop-down list (Figure 28) appears.

e Use it to select which test types to view in the Longitudinal Report: summative, interim, or a
combination.

e This drop-down list does not appear when only one test type is available.
Figure 28. Features & Tools: Longitudinal Report Button & Progression Drop-Down List

a'o Hawai'i, by Student and 222 Features & Tools.
e s

Longitudinal Report

i Reporting Optior
i a Cha
i Time

! Download & Print A
P Download Student @ —
¥ Resuts | Summative + Interim Mathematics

Test Options. ~ | SUmI.T]é]UVG.MthEII\:’JUCS
=, Manage Test A

Roster Settings A

Progression Select

e Teachers only: If the test results you’re looking at are for multiple students, a table appears with
a column for each test (Figure 29). This table does not appear if you’re looking at an individual
student.

— A sub-column appears for each test reason (a category of test, or a test window).

— The cells in the columns display checkmarks ¥  to indicate which students completed
which test/test reason combinations.

Figure 29. Teacher View: Longitudinal Report Window: Detailed Report Options Page

Longitudinal Report
e Mark the checkboxes for the tests you wish to compare, and then click Generate Report. The Longitudinal Report will
i only show data for students who completed every test you chose to include (the students highlighted in the table below)
Students Selected: 0

Test FAST Grade 4 ics  Grade 4 FAST ics  Grade 4 FAST

[ Test Reason PM12022-23 PM22022-23 PM3 2022:23
Fast22Mock0425, FAST22 v v v
02204251

Fast22Mock0426, FAST22 v v v
(F1000M0220478)
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— Mark the checkbox for each test/test reason combination you wish to include in the report.

Mark the Test Reason checkbox on the left to include all or clear it to remove all. The test
opportunities that will be included are highlighted in yellow.

o If you're viewing report options, click Generate Report at the top of the window to view the
Longitudinal Report. (You can modify your selections and regenerate the report later using the
Change Selections button)

View Students’ Overall Performance on These Assessments Over Time

Look at the graph in the upper-left corner of the Longitudinal Report (Figure 30). It shows the scores or
performance levels of the student(s) each time they took the test(s).

Score data are plotted along a line.

Figure 30. Longitudinal Report: Summative Report for a Student with Multiple Reporting Categories

Longitudinal Report

L inal report of Score and Performance on Grade 6 Math: demo, demo, 2020-2022

¥~ Change Selections | | 3 Filters v | | & Print

Filtered By Test Reasons:All Test Reasons  School Year: All Schoo! Years  Reporting Date: 09/23/2023 N 3
— -

Overall score - Concepts and Procedures

Date Test Label

Table 5. Longitudinal Report Window Elements

# Element

=

Overall performance graph

N

Overall performance section of table

3 Score/Performance Toggle

Performance level data are shown either the same way or, for multiple students, in performance
distribution bars.

Mouse over the data points in a line graph or the sections in a bar to get more information.

Alternatively, in the table at the bottom of the report, look at the Overall section.
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Switch Between Score Data and Performance Level Data

When a graph offers both score and performance level data, a toggle bar appears at the top of it (see
Figure 31). Click the toggle to switch. You may want to do this if you find performance level data easier
to read, or if you prefer the precision of score data. Sometimes a test includes only one type of data.

Figure 31. Longitudinal Report: Switch Data View

Longitudinal Report Longitudinal Report

Longitudinal report of Score and Performance or Longitudinal report of Score and Performance on
63 Demo?, 2020-2022 2020-2022

Filtered By Test Reasons: All Test Reasons  School Year: All Scl t Reasons: All Test Rezsons  School Year: All Sch
09/01/2023

Overal Overall Performance

View Students’ Performance in Different Areas Over Time

Look at the reporting category graphs to the right of the overall performance graph, or look at the
expandable reporting category sections in the table at the bottom. Here, you can understand at a glance
how students are improving or declining in each area, and you can compare their trajectories in
different areas (see Figure 30).

Distinguish Different Types of Tests in the Graphs

A symbol appears on each data point. When multiple test types are present, refer to the legend
immediately below the graphs (see Figure 32) to find out which symbols correspond to which types.

Figure 32. Longitudinal Report: Test Type Legend

Longitudinal Report
Longitudinal report of Score and Performance on Grade 3 English I - (I e 1
Language Arts: OST-Online-MOCK FN, 20202022 i Change Selections | | 3£ Filiers v | | & Print |
Filtered By Test Reasons:All Test Reasons  School Year: All School Years  Reporting Date:
0772142023

Overall Score Reading Informational Text Reading Literary T

.

[ ]
]

_ e - o
® » e oo o w-e (3

o A

@ Interim @l A Summative @l
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Modify the Test Groupings You've Selected

If you generated the report from the report options page, click the Change Selections button in the
upper-right corner of the window. The report options page reappears, allowing you to change your
selection of test type or types and, if you are a teacher viewing multiple students, your selection of tests
and test reasons as well. Click Generate Report again.

Alternatively, if your report contains multiple test types, click the test type toggles in the legend
immediately below the graphs (see Figure 32) to hide and show data for each one. Note that these
toggles do not affect report printouts or exports.

Filter Test Opportunities to Show Some and Not Others

You may want to filter a Longitudinal Report in order to focus on some test opportunities and not
others.

Note that filtering tests may affect the set of students whose data are included in the report.

1. Oen the Filters menu at the upper-right corner and select the filter options you prefer from the drop-

down lists.

Figure 33. Longitudinal Report: Filter by Test Opportunity and Year

Longitudinal Report ﬁ

Longitudinal report of Score and Performance on Grade 3 Math: HIDOE Only,
G3 Demo1, 2020-2022

Test Reasons: All Test Reasons  School Year: All School Years  Reporting Date:

x~ Change Selections 1 I:”E Filters v I [@ Print ]

School Year

2022 v

Overal Score Concepts and P
e Test Reason

. s Spring 2023 (Smarter Summative) v

Test Label

All selected (2 v

@ Smarter Summative @l A Interim Comprehensive Assessment (ICA) Ell

e You may want to filter by a particular school year or years. Note that years are not calendar years.
“2023” refers to the 2023—-2024 school year. By default, Longitudinal Reports show data for all
years.

e Longitudinal Reports can show student performance from a time when the students were not yet
associated with you. For example, if you are a seventh-grade teacher, you can use these reports to
view your current students’ performance on last year’s sixth-grade tests.

o If the report includes interim assessments, you may wish to filter by a test reason (a category of
test), which means excluding all other test reasons from the data. For example, you may want to
narrow the report down to show only tests taken in the spring.

29

spu0day alpBIADN



Centralized Reporting System User Guide

e For summative assessments, test reasons are the same as test windows and are not useful.

e Finally, you may find that certain individual tests are less relevant than others. In that case, you can
use the Test Label options to deselect the names of the tests you don’t want to view.

2. Click Apply.
3. Optional: To revert all filters to their defaults, open the Filters menu again and click Clear Filters. Click
Apply.

A row of filter details appears below the report header, showing the test reasons and school years included
in the report.

Complex-Level Users: View a Cross-Sectional Report

When the Cross-Sectional Report is available, complex-level users can view a school or complex’s
performance, irrespective of enrolled students, for a test family across multiple test reasons. This report
helps you understand how the institution’s performance has improved or declined across student
populations.

Unlike the Longitudinal Report, the Cross-Sectional Report does not track a particular set of students.
The set of students may vary across test reasons, depending on which ones were enrolled and took the
tests at the time.

A complex-level user can view a report for their complex area, complex, or any school within it.

Access a Cross-Sectional Report for an Institution and Test Family

When viewing either a School Performance on Test Report or a Complex Performance on Test Report for
a test that has a Cross-Sectional Report available, you can access the report using the Build Cross-
Sectional Report button in the Features & Tools menu.

1. Click Build Cross-Sectional Report in the Features & Tools menu. The Cross-Sectional Report
window opens, displaying report options (Figure 34).

Figure 34. Cross-Sectional Report Window: Report Options Page
Cross-sectional Report

Generate Report Mark up to three checkboxes for the test reasons you wish to compare, and then click Generate Report.

A 2022-2023

Spring 2023 (0SAS)
A 2021-2022

Spring 2022 (0SAS)
~ 2018-2019

Spring 2019 (0SAS)

2. From the list of school years and test reasons, select up to three test reasons you wish to compare.

3. Click Generate Report. The report appears (Figure 35), displaying data for the test family to which
the test belongs.

30

spu0day alpBIADN




Centralized Reporting System User Guide

View the Institution’s Overall Performance on This Test Family Over Time

Look at the graph in the upper-left corner of the Cross-Sectional Report (Figure 35). It shows the scores

or performance levels of the institution for each test reason.

Figure 35. Cross-Sectional Report Window (Scrolled to Top)

Cross-sectional Report

0SAS by School and ~ 2022-2023,

Cross-sectional reportof . o Reporting 2021-2022 [ x~ Change Selections | | = Print J
Score and Performance on ’
Science  Category: 2018-2019
Filtered by Test Reasons: Spring 2023 (OSAS), Spring 2022 (OSAS), Spring 2019 (0SAS)
Qverall Score 3-Dimensional Earth Performance 3-Dimensione
090 and Space Science Science
°
070
3060 .
3050
= P &
& & & S S s S
o o o & & &
) & i ) 2 o o
& & & & o & 5
& & & & Cid i o
o < o o o oF of .

# Overall and Reporting Category Level Performance

Performance Levels School Year & Test Reason

Score data are plotted along a line. Performance level data are shown in performance distribution bars.

Hover over the data points in a line graph or the sections in a bar to get more information.

Alternatively, in the first table at the bottom of the report (Figure 36), look at the Overall section.
Figure 36. Cross-Sectional Report Window (Scrolled Down)

Cross-sectional Report

A\ Overall and Reporting Category Level Performance

Performance Levels

2018-2019

School Year & Test Reason
2021 - 2022

2022 -2023

Spring 2019 (OSAS) | Spring 2022 (OSAS) = Spring 2023 (OSAS)

@ QOverall
Average Score 3065 @ 3070 @ 3082 @
%Level 1 100% 97% 92%
%Level 2 0% 3% 4%
%Level 3 0% 0% 2%
%Level 4 0% 0% 2%
Q 3-Dimensional Earth and Space Science
Average Score 3079 @ 3112 @ 3105 @
%Below Standard 94% 86% 84%
%At/Near Standard 6% 14% 13%
%Above Standard 0% 0% 3%
Q 3-Dimensional Life Science
Average Score 071 @ 3092 @ 3097 @
%Below Standard 100% 95% 94%
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Switch Between Score Data and Performance Level Data

When a graph offers both score data and performance level data, a toggle bar appears at the top of it.
Click the toggle to switch between data. You may want to do this if you find performance level data
easier to read, or if you prefer the precision of score data. Sometimes tests include only one type of
data.

View the Institution’s Performance in Different Areas Over Time

You can view the institution’s performance by reporting category or by standard.

e View the reporting category graphs to the right of the overall performance graph (Figure 35), or
view the expandable reporting category sections in the first table below the graphs (Figure 36).
Here, you can understand at a glance how the complex or school is improving or declining in
each area, and you can compare its trajectory in different areas.

e Look at the second table below the graphs (Figure 37), which breaks down performance by
standard. Again, this helps you understand at a glance how the complex or school is improving
or declining in each area.

Figure 37. Cross-Sectional Report Window (Scrolled Down)

Cross-sectional Report
A\ Target Level Performance
Targets School Year & Test Reason
2018 - 2019 2021 - 2022 2022 - 2023
Spring 2019 (OSAS) Spring 2022 (0SAS) Spring 2023 (0SAS)

Proficient? @  Strength? @ Proficient? @ | Strength? @ Proficient? @  Strength? @

e 3-Dimensional Earth and Space Science

Earth and Space Science

ESs1 @ Below — Below — Below -
Ess2 @ Below — Below + Below —
Ess3 @ Below - Below — Below —
€3 3-Dimensional Life Science
Life Science
Ls1 i ] Below —3 Below = Below —
Ls2 i ] Below — Below — Below -_
LS3 i ] Below — Below — Balow —
LS4 i ] Below —3 Below — Below —

g 3-Dimensional Physical Science

Modify the Test Reasons You've Selected

Click the Change Selections button in the upper-right corner of the window. The report options page
reappears, allowing you to change your selection of test reasons. Click Generate Report again.

View Test Results for Individual Students

You can find out how well an individual student understands the material covered on a specific
completed assessment. You can also view a report for all the assessments a student has taken.
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Note: 2023-2024For the Smarter Balanced ELA and Math assessments in Hawal'i, student claim or
target information is only available for claim 1 results for Math and claims 1 and 2 results for ELA at
the individual student level. This user guide provides instructions and figures (examples) showing
how to access this information for SY 2023-2024 aggregates, and for all claims in past years’
Smarter Balanced summative assessments at the student level, such as SY 2018-2019.

Access Test Results for an Individual Student on a Particular Test

Teachers and school-level users:

1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. A page of test results appears.
3. Select the Performance by Student tab.
4

Click the name of an individual student in the report. The Student Performance on Test report
appears (Figure 38).

Complex-level users:

1. Generate a dashboard and click a test group name.

2. Click a test name in the table of assessments. A page of test results by school appears.
3. Click a school name. The School Performance on Test report appears.
4

Perform the same steps as teachers and school-level users, starting at step 3.

Figure 38. Teacher View: Student Performance on Test Report

o @HAWAH Reporting [ Secure Flle Center @ Help  HIDOE, Demo PR v
Seloct Role > Dashboard Gonerator > Dashboard > Performance on Tests > School Performance on Test > Tost Enter Student ID Q
SE | score, Performance and Points Earned on Grade 4 MATH - Geom portunity 1) of Kula &0 Hawai, by Student and Reporting Category: 2023-2024 2 Features & Tools
Ties | FiteredBy Rosters: AllRoster | TestRessons:Cppeetnty | | Standards Keys

) Student Swdontid

-, 2

I Demo, Student 9999619892 Above Standard 1 1 it 1 Q ] 0 9 1 9 1 I

Rows perpage: 10 1 tems: 1 oft

Table 6. Teacher View: Student Performance on Test Report Elements

# Element

1 Row of data for the student
2 Reporting category section bar(s) (click to expand)

You can view the student’s performance in each area of the test using the reporting category sections,
which you can click to expand.
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View a Report for All the Assessments a Student Has Completed Over Time

The Student Portfolio Report (Figure 39). allows you to view all the assessments an individual student
has completed over time. This is useful for viewing performance on tests that have multiple
opportunities, and for interim tests that were administered multiple times throughout the year.

To access this report, enter the student's SSID in the search field in the upper-right corner and click the
search button. (When you are viewing the Dashboard Generator and data are available, the same field
appears to the right of the dashboard generation controls.) The Student Portfolio Report appears.

Teachers can also access this report from the Performance on Tests report by going to the My Students
table below the main assessments table and clicking a student's name.

Figure 39. Student Portfolio Report

Select Rele » Dashboard Generatgr » Dashboard » Student Portfolio I Enter Student ID O\I
—k .
3= Score and Performance, by Assessment and Test Reason: LAST1179 First1179, 2022-2023 i3t Features & Tools
Filkers
Teat Test Test Student Date
.’=:. Assessment Name Group Grade Reason Count Score Performance Taken
L 1]
Tent
cows | | Summative Grade 8 ELA A | summative 8 éi’;gfﬂgﬁf; 1 605413 n";’:ﬁ:ﬂ‘;‘;"m 03/14/2023
Summative Grade 8SCIENCE A | Summative 8 [‘cjsz'r‘:r?éfj:] 1 82427 Dogs Nt Meet ' 0370972023
Schasl
o ative Grad Spring 2023 . Does Not Meet
Summative Grade 8 MATH P Summative B (Summative) 1 495+ Standard 03/03/2023
Rows per page: 100 3 tems: 1 of1

To view individual test results for this student, click a test name in the Assessment Name column.

Use the Student Portfolio Report to View Only the Tests You’re Interested In

You can temporarily filter which tests you want to view in the Student Portfolio Report. You may want to
do this, for example, if you are an ELA teacher and you don’t want to view a student’s math scores. By
default, the data for those math assessments appear in the report, but you can exclude them.

1. Inthe Filters panel on the left side of the Student Portfolio Report, click the Test Groups button. The
Filters panel expands (Figure 40).

Figure 40. Student Portfolio Report with Expanded Filters Panel

Select Role > Dashboard Generator > Dashboard > Student Portfolio nter Student I Q
—F ’
Filters = Score and Performance, by Assessment and Test Reason: LAST1179 First1179, £ Features & Tools
2022-2023
"
Test Test Test Student Date
~ [ Checeaint & L= Group Grade Reason Count Scare Performance Taken ¥
~ [ Formative Summative Grade ” Spring 2023 . Does Not Meat
~ O inerim BELA A Summative B (Summative) 1 605113 Standard 0371472023
# O Science Summative Grade . Spring 2023 Does Not Meet
g iy RRLINLE A | Summative 8 | coummottve) 1 82427 Standard | 0309/2023
7 Summative Grade Spring 2023 Does Not Meet
BMATH A Summative 8 (ummatve) 1 495+ 21 Standarg | 0303/2023

Rows perpage: 100 3 tems: 1 of1
% ] Intesim Camprehensive
Assessment (ICA)

~ [ Summative

~ School Year
2022:2023 v _ v
Clear Filters

Apply
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2. Mark as many selections as you like in the Test Groups section of the Filters panel. Tests are
organized by test type, subject, and grade.

3. Click Apply. The Student Portfolio Report updates to show only data for those tests.

4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.

View a Student’s Performance on Tests Taken in a Previous School Year or Years

If there are multiple years of data for a student, the Student Portfolio Report can look back at previous
years. This gives you a high-level look at the student’s progress. Student Portfolio Reports can show
student performance from a time when the students were not yet associated with you. For example, if
you are a seventh-grade teacher, you can use these reports to view a current student’s performance on
last year’s sixth-grade tests.

1. On the left side of the page, expand the Filters panel, and click the School Year button (see Figure
41).

2. Under School Year, select a year or years (see Figure 41).

3. Click Apply.
Figure 41. Student Portfolio Report with Expanded Filters Panel
Select Role > Dashboard Generator > Dashboard > Student Portfolio ter Student Q
Filters -_T;" Score and Performance, by Assessment and Test Reason: LAST1179 First1179,
2022-2023

R SaminCad A |swmmae| 8 | 2OZNR| 1 605213 | DotsNatMeet | ga1ara023

[ i Y ] SunmatveGrade A | ymmative| 8 Spring 2023 > goas7 | DoesNotMeet o000

2022-2023 8 SCIENCE (Summative) e Standard
Rows per page: 100 3 Items: 1 of1
> Cloar Filters
Apply

To switch back to the current year:
1. Open the Filters panel again.
2. Click Clear Filters.

3. Click Apply.

Access Item-Level Data

Interim and benchmark assessments contain non-secure, non-public items. Reports for individual tests
include the following:

e [tem-level data.

e Access to the items themselves.

e Access to student responses to the items.
Test results for adaptive assessments include item-level data only on the individual student level.
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View Item Scores

To expand sections containing item data, click the vertical section bars.
Figure 42. My Students' Performance on Test Report: by Student Tab with Expanded Reporting Category

Select Role >

Find Out Which Items Students Performed on the Best or Struggled with the Most

@HAWAI‘I | Reporting

» Dashboard >

& by Roster |Peﬂarman:e by Student

Tesls > My Students’ Performance on Test

Ca secure File Center @ Help

Score, Performance and Polnts Eamed on Grade 3 MATH - Interim CAT Assessment (ICA) (Opportunity 1) of All Rosters, by Student and Reporting Category: , 2023-2024
Fiered By Rosters: &l Roster | Test Reasons:Oppcctunty | | Standards Keys 1

Student

State

Complex Area

Complex

School

My Students

Demo, Studer 2999980283
Demo, Stude: 9999980293
fack jil 9993002146

scale Score performance
wa wa
|zzzrrzz77)
252316 @ rew wn e
|z777777777)
5236 @ e - =
252316 @ M.:Mi— e
07228 @ Level
2524228 @ Level4
1427 @ Le,

¢ o - © S
g

Bunoseay Bunsouncauo) @

\sio s pawojiag SBPTIS ot u0 SIS @)

sempaoosg pus sideon @

srsjeuy e1eq § Buippon pue Bumos wajq

AUNear Standard

Performance

1pt

At/Near Standard
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pt | gt
we | wa
05

067 3

24

1pt

wa

pt

DemoUser, SC v
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Look in the sections 5 Items on Which Students Performed the Best and 5 Items on Which Students
Performed the Worst (Figure 43). You can click the vertical section bars to expand them, just like other

sections.

Figure 43. School Performance by Student Tab: 5 Items on Which Students Performed the Best and the
Worst Category Sections Expanded

A Texls > Sehool Performance on Test

Q

i3 Features & Tools.

Score, Performance and Points
s Rt 3Tt | TetRemonc o | Sandrt Koy
Stocent sttent 0+ @
£
e
Cams .
s of hems mased with & o

9 X0 A5 FAONS (A 10 SIS Q)

med on Grade 3 ELA - Interim (ICA) (Fall) of All Rosters, by Student and Rep

orting Category: Kula ato Hawali, 2022.2023

wosusis @

1510/ 243 PG SSPEUS I

-y
Gnburpnos @
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View Standards for Each Item

In a report displaying item-level data, you can view the standard or standards to which each item is
aligned. This allows you to determine at a glance what the item measures.

To show or hide item standards, click the Standards Keys toggle BB in the row of filter details below
the report table heading. Under each item number appears a standard key or list of standard keys
(Figure 44). Note that this toggle does not affect printouts or exports, which always include the standard
keys when they include item-level data.

Figure 44. School Performance on Test Report: Expanded Reporting Category Section

e @HA_\‘WN'! eporting B T Tatkioe| 3 Secum FieContes @ Help | Demobser 8¢ v

Sy Sy @

PeS——Y

506 04 DALY SRS D1 00 $sk S @
18200 58 B 85900 ORI U0 59 @)

Fousperpage: 10 S 1

Figure 45. School Performance on Test Report with Expanded Reporting Category Legend

@ TestsToScore 3 SecureFile Center @ Help DemoUser, SC v

iy @HAWAL | ¢

Secroies " onance on Tests > Tost Enter Student 1D Q
T ase
. performance by Roster | Performance by Student | i Features & Tools
[®) | Score, Performance and Points Earned on Grade 3 MATH - Interim CAT Assessment (ICA) (Opportunity 1) of All Rosters, by Student and Reporting Category: Kula a0 Hawail, 20232024
hovies | Fherea Sy Rosters: Al Roster | Teot Reascns: Opportrity 1 | Standarde Keys
.+ 2 0 S © © 0 00
g B e o B
S 5053 3 g Itern Numbers, Max Points and Points Earmed
g e 8|S
= EN B 2 > 2 24
Seale Score Performance SN AR Pertormance
g £ 2 z 2 soanal e 20ANAA o “ o ANETINAF ° 28T
A iE el
§ g g £ § 1 gt 19t
AR
stte . . i 7 : we P .
g 2 =
g i » . o ‘Contant Calegory: 4OA
Complex Area z 3 [ - 1l Agebraic Thinking 0s 1
iz : - Targe Set 40ANA Cper
& s o o
Complex rget: £0ANAA: Apply =
Comp Pt 30 e 1 1cs to salve problems ansing in 9a !
£ L fe. scciety, and the workplace.
o
sch R £ 1 0 o 1
” 037 @ Level1 AuNear standard 1 1
Demo, Student 9999619892 2518225 @ Leveld Above Standard 1 ] 1 1
o Sugent 9999980263 2507124 @ Level# AtNear Standard 1 ] 0 1

Click the more information ‘@ button beside the standard keys to view legends displaying the full text of
each cluster (category of standards) and each standard, as in Figure 45. This full text is not included in
printouts or exports.
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View an Item
On Interim and Checkpoint Assessments only, you can view the actual items themselves, along with
student responses to those items.
Do either of the following (see Figure 46):
e Toview the item in a blank state, click the item number in the first row of the report table.

e To view the student’s response to the item, find that student’s name in the student column on
the left. Then click the score the student obtained on that item.

Figure 46. My Students’ Performance on Test Report: Expanded Reporting Category Section

Select Role > Dashboart

Reporting C3 Secure File Center @ Help DemoUser, SC v

nerator > Dashboard >

on Tests > My Students’ Performance on Test ter Student Q

1
L

&= §
e ster [ Performance by Student i3 Festiyen & Tools
[@)  Score Performance and Points Earned on Grade 3 MATH - Interim CAT Assessment (ICA) (Opportunity 1) of All Rosters, by Student and Reporting Category: , 2023-2024
Suncurds | Fiered By Rosters: All Roster | Test Reasons:Opportunity 1 | Standards Keys |
s+ s - © [ 0 © 0 © ©
= @ o o o 3
g 21218 8 3
= SRAEEY
a @ 4 % item Nug ind Points Earned
ENE R
Scale Score performance 2|z (8 8 |% Performance 3
=l 2 |3 3
ol Z 'z 2 (= = = 2 = =
gllg | B¢ (2
§ § g8 & 2 pt 1pt 1pt 1pt 1pt
34 % |3 |3 '8
PO TR
State wa wa 2 2 a na wa na wa " a
2 2 »
. B2 g
e e : Gt = I )
Complex Area 252336 @  Pecen 008 - 2 | Percent S0% oy 1 05 05 1 05
Coune 4 2 = = com 2 2
2 2 &
77 © SN o
Complex 252346 @ | Pecent 100% Pescent 0% 0% 1 05 05 1 os
77 o S o
School 252346 @ | percem 100 Percent  50% e 1 05 2 1 05
A o [EETN e
My Students 252459 @ | percen T00% Percent o Ry 1 / 033 1 1 033
Coune B 2
Demo, Student 9999980283 2507:24 @ Level 4 At/Near Standard D Q
9999980293 2534:23 @ Level 4 Above Standard 1 1 1 1 : 2
jack jill 9993002146 2531227 @ Level 4 At/Near Standard 1 1 0 1 0

Table 7. My Students’ Performance on Test Report: Expanded Reporting Category Section Elements

# Element
1 Item number (click to view item without student response)
2 Item score for a particular student (click to view item with student response)

3 Average item score for the group (row) and the item number (column)

The Item View window appears (Figure 47). It contains an ltem & Score tab and a Rubric & Resources
tab. A banner at the top of the window displays the item’s number, score (when the item includes the
student’s response), and confidence level (when a machine-suggested score has a low confidence level).

The Item & Score tab shows the item and may include a particular student’s response.
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Figure 47. Item View Window: Item & Score Tab with Sample Student Response

1 2
Grade 5 MATH - Place Valy tem (FIAB)
—_— 3 \
[ £ ltemb6 t:  Demo, Student [ Item 8 »
Current Item: 7 Score: 0/1 I Item & Score I Rubric & Resources
Scoring Assertion Outcome
1. The student chose the correct answer. X
«— |4
Iltem / Passage Preview Redacted
Item Language:  English v

Table 8. Item View Window: Item & Score Tab with Student Response Elements

# Element
1 Item & Score tab

2 Rubric & Resources tab

3 Scoring Assertion Table

4 Iltem Preview

The Item & Score tab may include the following sections.

e Scoring Assertion: Each scoring assertion contains both a statement that provides information
about what the student did in their response, and the content knowledge, skill, or ability that is
evidenced by their response. When you’re viewing a student’s response and the item has
scoring assertions, the Scoring Assertion table appears, listing each assertion and outcome (see
Figure 47).

e |tem Preview: Displays the item as it appeared on the assessment in the Student Testing Site.
For items associated with a passage, the passage also appears (see Figure 47).

e Scoring Criteria: When you’re viewing a student’s response and the item has scoring criteria, the
Scoring Criteria table (shown in Figure 48) lists the name, maximum points, points earned, and
condition codes for each scoring criterion. This table also allows you to modify scores for items
with editable scores. Note that for some items, a second Scoring Criteria table appears,
displaying transformed scores.
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Figure 48. Item View Window: Item & Score Tab with Student Response and Scoring Criteria Table

Module: Writing Grade 8 Argumentative-B n
| 4( | T Gzde. Upez [ » |
Current ltem:1 Score: 3110 Item & Score Rubric & Resources
Scoring Criteria Max Points Earned Condition Code

Points
EDITING/CONVENTIONS 2 0 None
EVIDENCE/ELABORATION | 4 1 . None
'
STATEMENT OF
PURPOSE/FOCUS & 4 2 None
ORGANIZATION

student setting(s)

Read the opening passage of the novel Jacob’s Room, by Virginia Woolf,
below, and write a paragraph explaining how the opening sets the tone for
the rest of the book.

The Rubric & Resources tab (Figure 49) may include the following sections, which you can expand and

collapse by clicking Vland , respectively.
Figure 49. Item View Window: Rubric & Resources Tab

Grade 10 ELA - Interim (ICA)
‘7( Item 2 ‘ Item 11 - Currently Showing Item17 »

58558: America on the Move - Brief Write Item & Score | Rubric & Resources

v Details

Resource Description
Training Guide This document contains information on how to score items on the interims.
Exemplars A collection of scored student examples for teachers to practice scoring student responses

2 points

The response:

< proii i § § dinginf . ¢ ” » »

e Details: May provide the following information (if applicable to the test and/or item):
=  Topic: Skill area to which the item belongs.
= Difficulty: Indicates whether the item is intended to be easy, moderate, or difficult.
= Content Alignment: Describes the standard to which the item is aligned.

e Resources: Provides links to any exemplars or training guides available for the item.

e Rubric: Displays the criteria used to score the item. This section may also include a score
breakdown, a human-readable rubric, or an exemplar, which provides an example of a response
for each point value.

o Frequency Distribution of Student Responses: The table in this section provides a breakdown of
how many students in the school earned each possible point value available for a fixed-form test
item.
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View Items with and Without the Students’ Visual Settings

When viewing items with students’ responses, you may or may not want to view the items exactly the
way the students viewed them on the test. For example, some students’ tests are set to use large fonts,
different color contrast, or Spanish.

1. From the Features & Tools menu, select Set Student Setting on Item View.

student setting(s)

ve] Set Student Setting
—gx on ltem View @

2. The Set Student Setting on Item View pop up window appears.

3. Select Yes to show students’ visual settings on all items or No to hide them.
4. Click Save.

You can also show or hide visual settings on a per-item basis. To do so, click the toggle at the upper right
of the item you’re viewing. This action has no effect on your global setting.

View an Item in a Different Language

Items are displayed in English by default. If an item is available in multiple languages, you can use the
Item Language drop-down list at the upper-right corner to select a language.

Iltem Language:

Braille
Spanish

(=Y]

What It Means When a Student Response Contains Highlighted Text

When a student’s text response contains too much text copied from the item prompt and a condition
code of Insufficient Original Text to Score has been applied, the copied portion is automatically
highlighted.

Navigate to Other Items from the Item View Window

Use the buttons <2
Item View window.

labeled with the previous and next item numbers at the upper corners of the
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View Another Student's Response to the Current Item

If you have accessed the student’s response from a report showing multiple students, you can click the

. . [ - . . .
arrows beside the Student field | Demo Student | at the top of the window. The students are listed in the

same order in which they are sorted in the report.

What It Means When Items Are Labeled “1-1”, “1-2”, and So On

Those are sub-items belonging to an item cluster. Clusters are broken down into sub-items because they
have multiple scoring assertions. Each sub-item has its own column to the right of the main item
column. Sub-items are labeled “[item number]-[sub-item number]”, for example, “1-1”, “1-2”, “1-3”, as

in Figure 50.

Figure 50. School Performance on Test: Performance by Roster Tab with Expanded Total Items Section

Select Role > Dashboard Generator > Dashboard > Performance on Tests > School Performance on Test

=
;-m'e: Performance by Roster || Performance by Student

Enter Student ID Q

i1% Features & Tools

unity 1), by Roster and Reporting Category: Kula a'o Hawai'i

Average Score, Performance Distribution and Average Points Earned on Interim ES DCI - ES-LS1.[ 1
e
Standards 2022-2023
Filtered By Rosters: All Roster | Test Reasons:Opportunity 1 | Standards Keys = [l
e+ e o [ © 2
g g
S 5
B Itel mbers and Points Earned
Test =
Student . Average 7]
Count C°’;pl‘e“°n Score
ate I X 12 13 14 15
e o o o 3
S5pt 1pt 1pt 1pt 1 pt 1pt
State n/a n/a n/a n/a n/a n/a n/a n/a,
Complex Area 1 5/5 @ 5 1 1 1 1 1
Complex 1 5/5 @ 5 1 1 1 1 1
School 1 5/5 @ 5 1 1 1 1 1

Table 9. Item View Window: Item & Score Tab with Student Response Elements

# Element
1 Parentitem with maximum number of points
2 Sub-item(s) with maximum number of points

3 Average number of points earned for that item, in the group

To view a scoring assertion, click the more info button @ to the right of the sub-item number, as in
Figure 51.
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Figure 51. School’s Performance on Test: Performance by Roster with Expanded Sub-Item Assertion

Select Role > Dashboard Generator > D: > Performance on Tests > School P

-
e

on Test Enter Student ID Q

i3 Features & Tools

:m: Performance by Roster || Performance by Student

m Average Score, Performance Distribution and Average Points Earned on Interim ES DCI - ES-LS1.D (Opportunity 1), by Roster and Reporting Category: Kula a'o Hawai'i

nse | 20222023

Filtered By Rosters: All Roster | Test Reasons:Opportunity 1 | Standards Keys [l

e+ e o [ o I
g g
= £
3 Item Numbers and Points Earned
Student Cor:else‘tion Average é
Count Rpl Score
e 1 13 12 13 1-4 15
S0 J B 1 pt 1pt 1pt 1pt
The student selected “food bowl dropping
State n/a on the kitchen floor” for Step 1. providing n/a n/a n/a n/a
some evidence of understanding the model
components representing the
phenomenon.
Complex Area 1 1 1 1 1
Complex 1 5/5 @ 5 1 1 1 1 1

What It Means When an Item Score Reads “n/a”

You may sometimes find “n/a” instead of a score for an item. In some cases, the student did not
respond to the item, or the item was not included in that form of the test.

Use Individual Student Reports (ISR)

This section discusses Individual Student Reports (ISR), each of which provides easy-to-read
performance data on a student’s test. If a student took tests multiple times, an ISR will be available for
each test opportunity (an instance of a test the student took). ISRs are useful for sharing performance
information with students and their parents and guardians.

Figure 52. Page 1 of an Individual Student Report (ISR): Math Interim (ICA)

OHAWAI'I Reporting

Individual Student Report

HIDOE Only, G10 Demo1

Shudent 10: 8388820340 | Student DOB: 111811955 | Ervoled Grade: 10

Date Taken: &/182023

Grade 10 MATH - Interim CAT Assessment (ICA)
2023-2024

Traning Complex Area - A
Demo Scnool Growp 2
Kuta 3% rawant

Scale Score: 2354451 ‘Parformancs: Leve! 1

How Did Your Child Do on the Test?

How Does Your Child's Score Compare?

Information o Standard Error of Measurement

A Siserrs soore 5 best mereetes hen recognzng
7ot e chgents Knowleage 270 sl 131 WA 3

Category Performance
Reasoning ]
Concepts ans

Frocedures Ersniem

Prtiem Sovng
matooengs | ==l
ey e —
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What an Individual Student Report (ISR) Looks Like and How to Read It

An ISR is a PDF that shows results for a test opportunity. It may consist of a single page or multiple
pages. ISR layouts vary according to the type of test. Details of sample ISRs are shown below.

e At the top of each ISR are the student name and SSID, the name of the test, complex area,
complex, and school, and any other relevant information Figure 53).

e Below that is a summary of the student’s performance. An ISR for a scale-scored test displays
the student’s performance on a vertical scale that includes all the cut scores and performance

levels.

e Each ISR includes a comparison table showing the average performance of the state, complex
area, complex, and/or school.

Figure 53. Detail of Individual Student Report (ISR): Math Interim (ICA)

@ HAWALI'l | Reporting

Individual Student Report

Demo, Student

Student ID: 9999980283 | Student DOB: 12/12/2003 | Enrolled Grade: 3

Date Taken: 9/21/2023

Grade 3 MATH - Interim CAT Assessment (ICA)
2023-2024

Training Complex Area - A

Demo School Group 2

Kula a'o Hawai'i

Scale Score: 2507224

Performance: Level 4

How Did Your Child Do on the Test?
2762

Score
2507 =24

demonstrates adv:

Lmlmsmmselceededmem\evms

tandard and
anced progress toward mastery of the knowledge and skills
in mathematics needed for likely success in future coursework.

How Does Your Child's Score Compare?

Name Average Scale Score
Training Complex Area - A 252326
Demo School Group 2 252326
Kula ' Hawai 252326

for ikely success in future cou

Level 3 The student has met the achievement standard and demonstrates
progress toward mastery of the knowledge and skills in mathematics needed
rsework.

Information on Standard Error of Measurement

require further

mathematics needed for lxkefy success in fumr‘e ‘coursework.

A student's score is best interpreted when recognizing
B e e )y that the student's knowledge and skills fall within a

score range and not just a precise number. For
example, 2300 (£10) indicates a score range between
2290 and 2310.

How Did Your Child Perform on Different Areas of the Test?

The table and the

ra\pea‘lxkelyswesgywsl\nemwwldreeemeﬂheormmkmemmtdem

Category
Communicating
Reasoning
Concepts and
Procedures
Problem Solving

and Modeling &
Data Analysis

Performance
Secutne Stnows Above e Sncs
Secwine Stncad  Above e Siancrd

Seow the Stanaxd Above e Szanawd

Performance

V)
V)

Level 1 The siudent has not met the achievement standard and needs
and skills in
mathematics needed for likely success in fumre coursework.

The biack dot indicates the student’s score on each reporting category. The lines to the left and right of the dot show the

Below Standard At/Near Standard (@ Above Standard
Performance Description

Student can clearly and pracisely construct viable arguments to support their own
reasoning and to criique the reasoning of others.

Student can explain and apply mathematical concepts and interpret and camy out
mathematical procadures with precision and fluency.

Student may be able to solve a range of complex well-posed problems in pure and
applied mathematics. making productive use of knowledge and problem sol

Shniegios. Student mty be shie b analys canpiex. rasimcrid Saenarios and may be
able to construct and use mathematical models to interpret and soive problems.

e Many ISRs include a table detailing performance in each reporting category (Figure 53).

e Some ISRs include longitudinal graphs (as in Figure 54and Figure 55).
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Figure 54. Individual Student Report (ISR): Math Interim (ICA) with Longitudinal Graph

Trend Report
Legend
3000
. Level 1
2800
D Level 2
2600 . Level 3
. Level 4
2400 Estudanl Score
2200
2000
&
< @‘*’@
Date Test Reason Test Label Scale Score | Performance Level
8/17/2018 12:00:00 AM Unassigned Grade 3 MATH -COMBINED 2314 Level 1
2/27/2020 12:00:00 AM L i Grade 5 ics - Interim (ICA) - Combined 2746 Level 4

Figure 55. Detailed Individual Student Report (ISR): Summative ELA with Longitudinal Graph

Trend Report

Legend

[ [
D Level 2
2550 e
et

2950

2750

2350 Esmdem Score

2150

1950

N Q )
o
'\’\\\\ '\3’4‘9 '\\"b{&
Date Test Reason Test Label Scale Score Performance Level

11/17/2014 12.00:00 gg:'gg Smarter Balanced Summative English Language Arts Grade 3 2483418 Level 2
1/25/2017 12:00:00 AM gg:‘?g Smarter Balanced Summative English Language Arts Grade 3 230613 Level 1
1/14/2019 12:00:00 AM gg:‘gg Smarter Balanced Summative English Language Arts Grade 3 2327418 Level 1

e Some interim and benchmark ISRs include item-level data (as in Figure 56), scoring assertions,
and/or scoring assertion outcomes (as in Figure 57).
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Figure 56. Individual Student Report (ISR): Math Interim (ICA) with Item- and Standard-Level Data

How Did Your Child Perform on Each Test Question?

Communicating Reasoning
Guastion # Standard Points EamediPoints Poesible
[] Use ihe technique of Dreaking an argument Ino cases. (]
12 Distinguish comest Iogic of rasoring from hat which 15 Nlawad, and— thare Is a flaw In e agumant—explan what It 1s. 1
15 Stala logical assumplions baing used. (]
18 Use ihe fechrique of breaiing an argument Imo cases. (]
19 Dislinguish comet iogic or rasnring from ihat which 15 Niawad, and— tars 15 3 flaw N Me arumant—axplain what It 5. T
28 Test proposHions or CONECAINES With Specilc Sxamples. 1
i) Construct, autonomously, chains of reasoning that will jusify or refite propoeitions or conjectures. H
ET] Siate logieal assumptions being used. [T]
Concapts and Procadures
Question & Standard Points EamadPointz Possible
1 ‘Saive prodiams Invoiving ihe four operations, and idenify and expiain patiems In aTnmete. o1
2 Rapresant and soive proolems Invoiving muispication and dvision o1
3 Gapmetric measurement: understand concepts of anea and relate area fo muitiplicafion and to addfion. o
4 MURRYy and divide within 100. o1
5 Saoive prolems: Involving the four operations, and Idenfy and explain patberns In arfhmedic. o1
5 ‘Saive prodiams Invoiving ihe four operations, and idenify and expiain patiems In aTnmete. o1
7 Rapresant and soive proolems Invoiving muispication and dvision o1
a8 Gapmetric measurement: understand concepts of anea and relate area fo muitiplicafion and to addfion. o
10 Use place value Urdersianding and proparties of operations to perform mubi-digh anthmeic. o
11 FapraEaNt and S0iwE ProGIEmS Invoiving muspicaton and division o1
13 ‘Salve praskems Invohing the four operations, and identty and espiain pattems in afmmetc. o1

Figure 57. Individual Student Report (ISR): Science Interim with Scoring Assertions

@HAWAI‘I ‘ Reporting Individual Student Report
Demo, Student Interim MS DCI - MS-LS4.B 2022-2023
Student ID: 9999619972 | Student DOB: 12/12/2003 | Enrolied Grade: Grade 06 Training Complex Area A
Date Taken: 12/13/2022 Demo School Group 2

Kula a'o Hawai'i

Score: 0/5

What we can learn from your child’s response?

Information on Scoring Assertion

Each scoring assertion contains both a statement that provides information about what the student did in their response, and the content knowledge, skill or ability that is evidenced
by their response. For example, an assertion for a mathematics graphing item might be: The student comrectly graphed the correct function, showing evidence of the ability to model
relationships between two quantities

To ensure we capture every meaningful piece of information about a student's knowledge, skill or ability from his or her responses, each test item (question) is typically scored with

several scoring assertions.

Question # Scoring Assertion Outcome
The student graphed the data on the frequency of the dark color trait by drawing one line with coordinates at (0,1), (20,1), (80,48), (100,69), (180,95), and
1-1 (200,97) OR plotted the points with or without a line of best fit, providing evidence of the ability to generate a graph to describe the change in frequency of xX

a trait in a population over time.

12 The student selected "Between sample year 80 and year 100, the population shifted te mostly dark mice,” providing evidence of an ability to describe the
change in frequency of traits in a population over time.

13 The student selected "A change occurred in the landscape that gave the dark mice a survival advantage in dark terrain," providing evidence of an ability to
construct an explanation of the role of genetic vaniation in survival and reproduction.

14 The student selected "There will be no significant change in the frequency of the light and dark traits,” providing evidence of an ability to predict changes in
the frequency of a trait given a change of envircnment.

The student selected "the proportion of dark mice in areas of dark rock and soil in other regions,” “the proportion of dark mice in areas of sandy soil in

15 other locafions of the Soncran Desert,” "whether predator species, such as owls, in the area locate their prey by spotting it from above,” and "whether any
changes occurred in the terrain following the sample collection at year 20 of the study” as evidence to suppert the key in Part C, providing evidence of an
ability to identify evidence supperting the role of genetic variation in survival and reproduction.

X X X X

Generate and Export Individual Student Reports (ISR)

To generate and export an Individual Student Report (ISR) that details a student’s performance on a test
opportunity, use the Student Results Generator. You can select any combination of a test reason,
assessments within a subject, and students in order to generate either a single ISR or multiple ISRs at
once.

You may want to use the Student Results Generator to simultaneously print large numbers of ISRs.

ISRs can be generated from almost any Centralized Reporting page.
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J‘L Download Student

1. Click the Download Student Results button in the Features & Tools menu. |+ Results

The Student Results Generator window opens (Figure 58).

e Depending what page you open the Student Results Generator from, the options available to
you may be prepopulated or preselected; for example, the Student Portfolio Report
prepopulates a single student, and the Student Performance on Test report preselects a single
test opportunity. (The filters applied to the page have no effect, however.) You can change the
selections.

Figure 58. Student Results Generator Window as Opened from Performance on Tests Report

Student Results Generator

T
Repart Type Search by Student ID eparated studer =3

[Chodividust Student Report | ® Student Dt File

Print Options
Report Format
®xs csv T

Output

® Data File for Each Test Single Combined Data File

2. Inthe panel on the left, select Individual Student Report. Always do this before you make other
selections. Switching between the Individual Student Report and Student Data File options may
revert some selections.

3. If you're generating multiple ISRs, then under Report Format, choose either a single PDF for all the
ISRs, or a ZIP file containing a separate PDF for each one. If you select Single PDF, the Student
Results Generator may nonetheless create a ZIP file of multiple PDFs depending on the number of
schools, grades, and opportunities included.

Figure 59. Student Results Generator Window: Individual Student Report Options

Student Results Generator [
|
Reportityes Search by Student
® Individual Student Report Student Data File D Enter up to 5 comma-separated student IC m
Print Options 0 1
Report Format ‘ - Spring
®Single POF O Multiple PDFs in a ZIP file g Spring 2023 (EOC)
3
PDF Type g Spring 2023 (HSA)
® Simple ) Detailed >
g Spring 2023 (HSA-Alt)
3

Spring 2023 (Smarter Summative)
Summer 2023 (EOC)

Unassigned

‘ Winter
Cancel
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4. Under PDF Type, select either a simple or detailed PDF.

®  The simple (one-page) ISR includes the student’s overall scale score, statewide comparison data,
and simplified reporting category information (if available for that assessment).

B The detailed (multiple-page) ISR includes the same information as the simple ISR plus more
detailed reporting category information (if available for that assessment) and the student’s
longitudinal chart (if available for that assessment and that student).

— For the Smarter ICAs the simple (one-page) ISR includes the student’s overall scale score,
statewide comparison data, and simplified reporting category information.

— For the Smarter ICAs the detailed (multiple-page) ISR includes the same information as the
simple ISR plus more detailed reporting category information (if available for that
assessment) and the student’s longitudinal chart (if available for that assessment and that
student).

— For the Smarter IABs, the ISR will provide the student’s item level scores.

— For the NGSS Interims, the ISR will provide the student’s item level scores and assertion
outcomes for the assertions represented by the items/clusters on the test.

— For HSA-AIlt CEAs, the ISR will provide the student’s raw score, reporting category raw score,
item level scores, comparison data, and a count of “NR” responses.

5. Optional: If supplemental materials are available, such as a cover page or addendum, select Include
under Supplemental Materials.

6. If the test opportunity options are not preselected, or if you want to change them, there are two
ways to make selections:

e Search for students. In the search field at the upper-right corner, enter up to 5 comma-
separated student IDs and click Search.

= The resulting list of students and all the tests they've taken will replace any previous
selections, as in Figure 60.

=  To deselect and clear results, click Clear Search Results.

Figure 60. Student Results Generator Window: Student Search Results

Student Results Generator

Report Type Search by Student
® Individual Student Report - Student Data File D [ 123456789, 987654321 ]m

Print Options

Select the Students.

Report Format

® Single PDF Multiple PDFs in a ZIP file Demo, Student (9988619891)
Test Reasons: Spring 2023 (HSA)
Subjects: Science

PDF Type
® simple Detailed

Supplemental Materials

® Do Not Include Include

W Fonoe
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e Use the three accordion sections. (If a student is prepopulated by the Student Portfolio
Report, first remove the student by clicking Clear Search Results.) Starting from the left,
click the section bars to expand them or use the Next and Previous buttons to navigate.
Within each section you must make selections using the radio buttons and checkboxes:

B |n the Select Test Reason accordion section (Figure 61), choose a test reason, then click
Next. Test reasons are either test windows or categories for tests.

Figure 61. Student Results Generator Window: Select Test Reason Section

Student Results Generator

ST _ Search by Student ID
@ Individual Student Report (O Student Data File

Print Options ? Select a test reason. MNext ? ?
Report Format r £ £
Single POF O Multiple PDFs in a ZIP fil
@ Sing ) Multiple PDF5 in a & E @ 15t opportunity % g
& &
PODF Type o O 2022-2023 (ELPAZ21 Screener) E
@simple O Detailed g ; -
2 | O 20dopportunity S
O AMlELPA_22 23

O Spring 2023 (ELPAZ1 Summative)

7 Spring 2023 (Summative)

O summer 2022

3 Summer 2023
Generate Cance
O Unassigned

B |n the Select Assessments section (Figure 62), choose any number of tests or grade
levels within a single subject, then click Next.

Figure 62. Student Results Generator Window: Select Assessments Section

Student Results Generator

R t Ty
AEP‘" ype = Search by Student
Indmdual Student Report ) Student Data File D Enter up to 5 comma-separated student IDs w

Print Options 0 Q 0
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®simple O Detailed 7 % v O Mathematics -
o S
g 13
a2 |z

~ @ Science
~ [ Grade 5
[J Interim ES SEP - Argument

Interim ES SEP - Data

Generate Cancel
| Interim FS NCI - FR-FSST R
- »

®  |n the Select Students section (Figure 63), choose students from the expandable school
and/or class (roster) options. If you’re a complex-level user, you may choose students in

up to three schools.
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Figure 63. Student Results Generator Window: Select Students Section

Cancel
4

®  Sometimes the list of students is truncated. You can display the entire list by clicking Click to

Load More.

®  Note that marking the checkbox for a student in one class (roster) or school also marks it
anywhere else the student appears, and the same goes for clearing the checkbox.

7. Optional: If you used the accordion sections to make your selections, then to set a range of
processing dates for which to generate results, use the filter menu as follows:

a. Open the Filters menu. The menu displays two date fields, as in Figure 64. Use the
calendar tools to select dates, or enter them in the format mm/dd/yyyy.

b. Click Apply.

c. Optional: To revert to including results for all available dates, reopen the filter menu,

Student Results Generator
Repoives . Search by Student
® Individual Student Report O Student Data File D w
S—
Print Options ® 0°lo N 2020 SC Demo Roster 2
Reportromats 5 o |5 | v B 20235C DemoRoster 1
@® Single PDF Multiple PDFs in a ZIP file -
2 2 2 v [J 2023 SC Demo Roster 2
PDF Type -
® Simple ) Detailed % E é& v [J 2023 SC Demo Roster 2
@ 3 @
g |2 ~ [ HIDOE UAT Roster 23-24
> @

) HIDOE UAT Roster (2) 23-24

") (Students Not In Any Roster) I
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23-24 Reporting Demo Roster

click Clear Filters, then click Apply.

Note that the processing date is not always the same as the date a test was taken.

Figure 64. Student Results Generator Window: Select Students Section with Filters Menu Open

Student Results Generator

Report Type
@ Individual Student Report

/

Student Data File

Print Options

Report Format

® Single PDF Multiple PDFs in a ZIP file
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Cancel
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g 8 ¥
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4 B
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8. Click Generate (see Figure 63). Once ISR generation is finished, the Secure File Center contains the
new ISR(s) available for download (see Figure 65).

Figure 65. Secure File Center with Student ISRs Available

| Secure File Center

== Sealp fis Gene) R

!
\
| Recent Archived
|
{
Rl - - o

Reporting - KulaaoHawaii_StudentISRs_163153261 09/12/2023 1012/2023
PM.zip Reporting 10:31 AM 10:31 AM
~ Custom Labels
[ sHow | = KulaaoHawaii_StudentISRs_163005768  0g/12/2023 1011212023 @ .ﬁ
PM.zip Reporting 10:30 AM 10:30 AM
View | 20 w ‘

Note that if a student took a test multiple times with different test reasons, an ISR will be generated for
each test opportunity. If a student took a test multiple times with the same test reason, only one test
opportunity will be included. You can create an ISR for another test opportunity by navigating directly to
the report for that opportunity. Past test opportunities are marked with numbers 1 in reports, starting
with the earliest.

Generate and Export Student Data Files

This section discusses student data files, which are useful for analysis.

To generate and export student data files, use the Student Results Generator. You can select any
combination of a test reason, assessments, and students in order to generate and export the files.

You can generate student data files from almost any report page.

JL Download Student

1. Click the Download Student Results button in the Features & Tools menu. i S

The Student Results Generator window opens.

Depending what page you open the Student Results Generator from, the options available to you
may be prepopulated or preselected; for example, the Student Portfolio Report prepopulates a
single student, and the Student Performance on Test report preselects a single test opportunity.
(The filters applied to the page have no effect, however.) You can change the selections.

2. Inthe panel on the left, select Student Data File, as in Figure 66. Always do this before you make

other selections. Switching between the Individual Student Report and Student Data File options
may revert some selections.
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Figure 66. Student Data File: Student Results Generator Window

Student Results Generator

Report Type
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Jnassigned
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3. Under Report Format, select XLS (Excel, XLSX), CSV (comma-separated values), or TXT (tab-delimited

text).

4. Under Output, select either Data File for Each Test or Single Combined Data File. Note that a single
combined file does not include reporting categories. Large files may be split by school.

5. If the test opportunity options are not preselected, or if you want to change them, there are two

ways to make selections:

e Search for students. In the search field at the upper-right corner, enter up to 5 comma-
separated student IDs and click Search.

®  The resulting list of students and all the tests they’ve taken will replace any previous

selections, as in Figure 67.

®  To deselect and clear results, click Clear Search Results.

Figure 67. Student Results Generator Window: Student Search Results

‘ Student Results Generator

|
| Report Type
Individual Student Report ® Student Data File

Print Options

| Report Format
® XLS csv TXT

Output

® Data File for Each Test Single Combined Data File

Search by Student .
1] d o &

Select the Students.

Demo, Student (9988619891)
Test Reasons: Opportunity 1
Subjects: Mathematics
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e Use the three accordion sections. (If a student is prepopulated by the Student Portfolio
Report, first remove the student by clicking Clear Search Results.) Starting from the left,
click the section bars to expand them or use the Next and Previous buttons to navigate.
Within each section you must make selections using the radio buttons and checkboxes:

B |nthe Select Test Reason section (Figure 68), choose a test reason, then click Next.
Test reasons are either test window or categories for tests.

Figure 68. Student Results Generator Window: Select Test Reason Section

Student Results Generator

R t Ty
fpm i = Search by Student
O Individual Student Report @ Student Data File D Enter up to 5 comma-separated student IDs m
Print Options Q 0
Report Format a Select a test reason. Next N
®xts Ocsv OTXT 2 2

o o
Output ) O Fall =

2 8
® Data File for Each Test g ® Opportunity 1 g

3

° o

3 O Opportunity 2 %

O Opportunity 3
O Opportunity 4

D Opportunity 5

Canee| o
) Post-Test

®  The Select Assessments section (Figure 69) groups tests by subject and grade. Mark the
checkboxes beside the tests or groups of tests you want to include in the report or mark

All Subjects, then click Next.
Figure 69. Student Results Generator Window: Select Assessments Section

Student Results Generator
Rjeporl Ui - Search by Student
O Individual Student Report @ Student Data File D Enter up to 5 comma-separated student IDs m
Print Options 0 @ 0
Report Format bl | Select the assessments. Previous m I| w
® - ol o S 73
® O Q ® © \J ©
Sk Sy 2123} g g All Subjects g
Bl B 2
O‘mpm ~ 02 ~m@eEn &
@ Data File for Each Test O Single Coml B 3
Sub scores W : 213 ~ @ Grade3 2
only S k=
I scores/measures will be Ll R
included. Grade 3 ELA - Interim (ICA)
Grade 3 ELA - Brief Writes (IAB)
Grade 3 ELA - Research: Use Evidence (FIAB)
‘ »

B |n the Select Students section (Figure 70), select any number of students from the
expandable school and/or class (roster) options.

— Sometimes a list of students is truncated. You can display the entire list by clicking
Click to Load More.
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— Marking the checkbox for a student in one class (roster) or school also marks it
anywhere else the student appears, and the same goes for clearing the checkbox.

Figure 70. Teacher View: Student Results Generator Window: Select Students Section

Student Results Generator
| [[eioe Search by Student
Individual Student Report  ® Student Data File D nter up to § comma-separats ’ m
Print Options ° olo
® xs csv T g ;ﬁ £
Uit = All Students
. fo 2 8 15
Data File for Each Test s\?gle(?otnn\ngz?l??xar‘.{e‘ g % | v 01 HiDOE UAT Roster () 2326
n ti S
o - - v [ (Students Not In Any Roster)

7. Optional: If you used the accordion sections to make your selections, then to set a range of
processing dates for which to generate results, use the filter menu as follows:

a. Open the Filters menu (Figure 71). The menu displays two date fields.
b. Use the calendar tools to select dates, or enter them in the format mm/dd/yyyy.

c. Click Apply.

d. Optional: To revert to including results for all available dates, reopen the filter menu,
click Clear Filters, then click Apply.

Note that processing date is not always the same as the date a test was taken.

Figure 71. Teacher View: Student Results Generator Window: Select Students: Filters Menu Open

Student Results Generator
Repor ype U pErr——r——r— .. |
O Individual Student Report @ Student Data File

i ® 0o
o Y 2 ¥ scloctthe students. P——
Report Format g & 2
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(® Data File for Each Test () Single Combined Data File % ¥
B & o [0 12234123411223412f Sten Date &
- M Rosters End Date &
v (Students Not In Any
Apply Cancel

8. Click Generate. Once data file generation is finished, the Secure File Center contains the new
student data file(s) available for download.

Note that if a student took a test multiple times, the files will include each test opportunity.
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Compare Students’ Data with Data for Your State, Complex, School, and/or Total
Students

In the Performance on Tests report and the Student Portfolio Report, you can access performance data
for your state, complex area, complex, school, and/or total students.

Compare All Your Students’ Performance on Any Test with Larger Groups’

In the Performance on Tests report (Figure 72), click | % to the right of a test name.

Figure 72. Teacher View: Performance on Tests Report
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Rows per page: |10 4hems 1o

Rows containing data for the state, complex area, complex, and/or school appear below, as in Figure 73.

Figure 73. Teacher View: Performance on Tests Report with Expanded Comparison Rows

Hov @H WA"' Rey Ca Secure File Center @ Help DemoUser, SC v
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Fitered By Rosters: All Roster | Test Reasons: AllTest Reasons |

To hide the comparison rows, click | # to the right of the test name.

Compare a Student’s Performance on Any of Their Tests with Larger Groups’

In the Student Portfolio Report, you can compare a student’s performance on any test with that of your
state, complex area, complex, school, and/or total students.

55

spu0day alpBIADN



Centralized Reporting System User Guide

1. Enter the student's SSID in the search field in the upper-right corner and click the search button.
(When you are viewing the Dashboard Generator and data are available, the same field appears to
the right of the dashboard generation controls.) The Student Portfolio Report appears.

Teachers can also access this report from the Performance on Tests report by going to the My
Students table at the bottom of the page and clicking a student's name.

2. Click | s to the right of a test name (Figure 74).
Figure 74. Student Portfolio Report
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Rows per page: 10 2 ltems: 1 of 1

Rows containing data for your state, complex area, complex, school, and total students appear below, as
in Figure 75.
Figure 75. Student Portfolio Report with Expanded Comparison Rows

‘
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To hide the comparison rows, click | #+ to the right of the test name.
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Set Up Reports to Suit Your Needs

You can set up your reports so it’s easier to access the data that are most important to you. For
example, if you're a teacher, you may want to hide certain tests in subjects you don’t teach, or you may
want to narrow down your reports to a single roster.

This section explains how to make several different adjustments to reports: showing only the tests
you’re interested in; showing only the classes (rosters) you’re interested in; showing only the schools
you’re interested in; assigning and filtering by interim test reasons; filtering item-level data on interims
by standards and clusters of standards; and viewing data from a previous point in time.

Filter Tests to Display

You can filter the tests you want to view in reports. You may want to do this, for example, if you are an
ELA teacher and you do not want to view your students’ math scores. By default, the data for those
mathematics assessments appear in your reports.

Filtering tests to display begins on the Dashboard Generator page. This is where you can select the test
groups you want to view on the dashboard and, as an option, set those selections as defaults. You can
also temporarily filter the tests that appear in the reports you are currently viewing, as described below.

1. On the left side of the dashboard or the Performance on Tests report, click the Test Groups button.

The Filters panel expands (Figure 76).

2. Mark as many selections as you like in the Test Groups section of the filters panel (Figure 76). Tests
are organized by test type, subject, and grade.

Figure 76. Complex-Level User View: Dashboard with Expanded Filters Panel
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3. Click Apply. The report updates to show only data for those tests.
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4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.
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Teachers and School-Level Users: Filter Classes (Rosters) to Display

Rosters usually represent classes, but can represent any group that’s meaningful to users, such as
students who have taken honors courses. Each roster is associated with a teacher. To learn how to
create and modify rosters in the Centralized Reporting System, refer to Class (Roster) Management.

In the Performance on Tests report, teachers and school-level users can filter by a particular roster.
When you filter, you eliminate students not in the selected class from the data you’re viewing.

Filtering by roster makes it easy to focus on a particular class’s performance. And by switching filters,
you can easily compare one class with another. If you don't filter by roster, the reports default to
showing data for all classes. You may find data for a single class easier to understand.

1. On the left side of the Performance on Tests report, click the Rosters button. The Filters panel
expands (Figure 77).

2. Make a selection from the drop-down list in the Rosters section.

e If you're a school-level user, you must first select a teacher from the drop-down list, and
then select a particular class (roster) from the second drop-down list that appears. By
default the first class listed is selected.

Figure 77. Teacher View: Performance on Tests Report with Expanded Filters Panel
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3. Click Apply. The report updates to show only data for that class (roster).

4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.

All the reports accessible from this page will be filtered the same way.

The row of filter details below each table header shows the classes (rosters) you're viewing.
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Complex-Level Users: Filter Schools to Display

Filtering the Performance on Tests report by school makes it easy to focus on a particular school’s
performance. And by switching filters, you can easily compare it with another school. If you don’t filter
by school, the Performance on Tests report defaults to showing data for all schools. You may find data
for a single school easier to understand.

1. On the left side of the Performance on Tests report, click the Schools button. The Filters panel
expands (Figure 78).

2. Make a selection from the drop-down list in the Schools section (Figure 78).

Figure 78. Complex-Level User View: Performance on Tests Report with Expanded Filters Panel

v @ HAWAI‘l Reporting (@ TestsToScore  [@ Secure File Center @ Help DemoUser, SC v

Sudent 1D Q

Select Role » Dashboard Generator > Dashboard > Performance on Tests Enter

IFllters Average Score and Performance Distribution, by Assessment: Demo School Group 2, 2023-2024 131 Features & Tools
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[Toa A TestGroups
B2 Assessment Name Test Group TestGrade © TestReason o Aversge Performance Distribution Dais Lasir s
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v :;:g‘yﬁ::mz’x“‘*“ R WV Assessment 6 Winter 1 n/a 08/25/2023
t Blocks (IAB)
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3 ELA - Listen/literoret Interim
= &; | SEERRA Bate e v Assessment 3 Winter 0 na 08/24/2023
[ ~ TestReasons i Blocks (IAB)
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All Test Reason: & ;L:::::\!L-R\ Performance Task v SSSTan 3 Fall 1 Wa 07/31/2023
’ Blocks (IAB)
A Schools liah Sch A5 e i amead Interim
& &, | tighSchool ELA- Licten/interprel essment " Unassigned 1 n/a 07/27/2023
All Schools < - Blocks (IAB)
Interim
igh Schoo! and Revist
& Ew;\:r‘f‘v“at T sessment n Winter 0 n/a n/a 07/19/2023
U Blocks (IAB)
. Interim A SIS
Clear Filters &, | Grade 5 ELA - Revision (1AB) V' Assessment 5 Opportunity 1 1 n/a n 07/18/2023
Blocks (IAB) o
Apply
Interim [
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3. Click Apply. The report updates to show only data for that school.

4. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters also revert when you log out, switch user roles, or switch systems.

If you click the name of a test when you’ve filtered by a single school, the link will take you to the School
Performance on Test report and not to the Complex Performance on Test report.

The row of filter details below the table header shows the schools you’re viewing.

Assign Test Reasons (Categories) to Interim Test Opportunities

Test reasons are categories used to classify test opportunities for reporting purposes. They typically
indicate the timeframe in which tests were taken, and they’re a good way to organize tests into groups.

Test reasons should ideally be assigned in the Test Administration Site at the time of testing. However,
you can use the Test Reason Manager in the Centralized Reporting System to assign a different test
reason to an interim or benchmark test opportunity that was completed in the present school year.
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1. From the Features & Tools menu, select Manage Test Reasons. The Test Reason Manager window

opens (Figure 79).

Figure 79. Test Reason Manager Window

Test Reason Manager

Session ID: Flease Type a Session ID

Test Reason Filter Select a Test Reason ¥

Session Starl Date:

Please select a dale range no more than

== Search Test Sessions for Test Reason

= End Date ]

2. To search for the test opportunities you wish to categorize, do either of the following:

o Inthe Session ID field, enter the session ID in which the opportunities were completed in

TDS.

e Select the test reason associated with the opportunities you want to edit. Then select a
range of dates during which the test session was administered. The date range cannot

exceed seven days.

3. Click Search.

4. Alist of retrieved test sessions appears in the section Select Test Opportunities (Figure 80). You can
click the 4 buttons to expand the list of tests in each session and the list of students who took

each test (that is, individual test opportunities). To navigate through a long list, use the controls in

the upper-right and lower-right corners.

Figure 80. Test Reason Manager Window: Select Test Opportunities

Test Reason Manager

—  Search Test Sessions for Test Reason
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5. Mark the checkboxes for each session, test, or opportunity that you wish to assign to a test reason.

6. Click Assign Test Reasons below the list of retrieved sessions.

7. Inthe window that appears (Figure 81), select a new test reason to assign to the selected

opportunities and click Confirm.

Figure 81. Confirm Test Reason and Assign Opportunities Window

Test Reason Manager

Session ID: Please Type a Session ID
TestRessonFiter | Any .
Session Sar Date eraote £ eose | omosao

o

== Search Test Sessions for Test Reason

m Piease select a date rangs no more

Confirm Test Reason and Assign Opportunities

Please Selecta Test Reason: Select a TestReason v

Select Test Opportuni

SessionID 4  StudentName ¢ StudentiD $ TestTaken

4 | Cument TestReason Assigned $

UAT-0COB-1 Last, First

99997771013 Grade 05 ELA - PerfTask (ICA) Unassigned

Rows per page: | 5 1 ltems: 1 |of1

Confirm Cancel

I T T N

¥l Student, Demo DemoStudentiDi Unassigned

+ Grade 05 ELA - FixedForm (ICA) ELA orade 5 1

Rows per page: [ 10 2ltems 1 |or1

Assign Test Reasons

Filter by Test Reason (Category)

Test reasons (shown in Figure 82) are categories used to classify test opportunities for reporting

purposes. They typically indicate the timeframe in which interim and benchmark tests were taken, and
they can be a good way to focus on specific groups of tests. For summative assessments, test reasons

are simply test windows and are not useful.

Figure 82. Teacher View: Performance on Tests Report

Select Role » Dashboard Generator » Dashboard » Performance on Tests

= A My Assessments

Enter Student ID

Q

i1t Features & Tools

Average Score and Performance Distribution, by Assessment: All Rosters, 2022-2023

ﬁ Filtered By Rosters: All Roster | TestReasons:All Test Reassns |
e

e Assessment Name. TestGroup © Test Grade
& s e
ct ] &, Test 547498 Math 1/1 v Test Authoring 6
T
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&, | Test5474 ience 1/1 W Test Authoring 4
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&, | Test 546812 WV 1/17 w | Test Authering 6

. My Students

Most Recent Assessment of All Rosters: 2022-2023
Filtered By Rosters: All Roster | Test Reasons: All Test Reasons |

Swdent Name Student ID
Test Test 716623001
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When your test opportunities have test reasons, you can filter reports by a single test reason. For
example, you may want to filter by Fall and look at ELA performance, then filter by Spring and find out if
students have improved on ELA material. If you don’t filter, you'll view data for all different test reasons.
This will allow you to compare multiple test reasons side by side rather than a single test reason. You
may find reports easier to understand when you’re viewing only a single test reason.

The Test Reasons filter is available on the dashboards and Performance on Tests reports for teachers as
well as for school- and complex-level users.

1. On the left side of the dashboard or Performance on Tests report, click the Test Reasons button. The
Filters panel expands (Figure 83).

2. Make a selection from the drop-down list in the Test Reasons section.

Figure 83. Complex-Level User View: Performance on Tests Report with Expanded Filters Panel

Reporting @ TestsToScore [ SecureFile Center @ Help DemoUser, SC v

shhoard > Performance on Tests Enter Student ID Q

rage Score and Performance Distribution, by Assessment: Demo School Group 2, 2023-2024 it Features & Tools

lkered By School: All Sehools | Test Reasons: Al T

Performance Distribution Data Lags

Assessment Name Test Group TestGrade © TestReason Core o e

Unassigned 1 09/06/2023

. W
B Grade § ELA - Revision (IAB) v rtunity nia per oo 7/18/2023
m Blocks (IAB)
Interim [ le

3. Click Apply. The report updates to show only data for that test reason.

4. Optional: To revert all filters to their defaults, open the Filters panel again and click Clear Filters.
Click Apply. Filters will also revert when you log out, switch user roles, or switch systems.

All the reports accessible from this page will be filtered the same way.

The row of filter details below the table header shows the test reason selected, if any.

Filter Item-Level Data on Interims by Standards and Clusters of Standards

An educational standard, sometimes called an assessment target, describes the skill the item measures.
An example of a math standard is “At later grades, determine conditions under which an argument does
and does not apply. (For example, area increases with perimeter for squares, but not for all plane
figures.)”

You may want to determine how your students performed on a particular standard or cluster of
standards. In certain reports, you can filter by the standard to which items are aligned. That way you can
view your students’ performance in just one area of skill. Then you can switch filters to compare it with
their performance in another skill. If you don’t filter by standard, the reports will show results for all
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standards by default. You may find that switching between different sets of standard data and
comparing them helps you understand students’ abilities better.

Standard filters are available in any report showing item-level data. The available standards vary by
assessment.

1. On the left side of the page, click the Standards button. The Filters panel expands (Figure 84).

2. Use the drop-down list in the Standards section to select a cluster. An additional drop-down list
appears.

3. Optional: Keep making selections from the drop-down lists as they appear.

Figure 84. My Students’ Performance on Test: Performance by Roster Tab with Expanded Filters Panel

v @ HAWALI‘I ‘ Reporting C3 secureFile Center @ Help ~ DemoUser, SC v
Select Role » Dashboar nerator > Dashboard > Performance on Tests > My Students' Test Enter S tiD o\
Filters =l —

S Performance by Roster || Performance by Student i1 Features & Tools
[.‘.] A poinas Average Score, Performance Distribution and Average Points Earned on Grade 3 MATH - Geometry (FIAB) (Opportunity 1), by Roster and

Reporting Category: 2023-2024
Filtered By Rosters: All Roster | Test Reasons: Opportunity 1 | Standards Keys - Il

Roster

swey 201 @

Test
Completion Performance Distribution
a

Student
Count

1598 84} PALLLIOIAd SIUBPNIS LOIYM L0 SWaY S @

1SI0M B} PAULIOIE SIUBPMS LOIYM U0 SWaY § @)

School 5 Perert  20% 2
My Students 4 Percert 2% 2% 0%
Coun

2024 Reporting UAT De 4 48%(4/9) | pucem 23n 2 ~

Clear Filters

Rows perpage: 10 1 items: 1 of1

4. Click Apply. The affected report updates to show only the items that belong to the selected cluster
or standard.

5. Optional: To revert all filters to their defaults, open the filters panel again and click Clear Filters.
Click Apply. Filters will also revert when you log out, switch user roles, or switch systems.

All the reports accessible from this page will be filtered the same way.

The row of filter details below the table header specifies the standards selected, if any.

View Data from a Previous Point in Time

Changing the reporting time period allows you to view test results from a previous point in time. There
are two time period settings: you can select a school year for which to view tests, and you can enter a
date for which to view students.
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e When you set a school year for which to view tests, the reports show data for test opportunities
completed in the selected school year.

e  When you set a date for which to view students, the reports show data only for the students
who were associated with you on the selected date and only for tests taken as of that same
date. Students’ enrollment and demographic information is all given as of the selected date as
well. You can use this setting to view data for students who have left or recently entered your
classes (rosters), school, complex area, or complex.

If you don’t change the reporting time period, or if you reset it to the default, all the reports show test
opportunities only for the current school year (except Longitudinal Reports, Cross-Sectional Reports, and
Student Portfolio Reports, which always retain the ability to look back to previous years), with current
student and test data.

Some examples of how you can use this feature:
e You may want to view the past performance of your current students, including new transfer

students. In that case, set a school year in the past and keep the date set to today.

e You may want to view the past performance of your former students in order to compare them
with that of your current students. In that case, set the date to a time when your former
students belonged to you and had tested, and set the school year to the same time. Then switch
back to the present to compare.

1. From the Features & Tools menu, select Change Reporting Time Period. (If you're viewing the
Dashboard Generator page, click Change the reporting time period. The dashboard also offers this
link when no assessments are available to display.) The Change Reporting Time Period window

appears (Figure 85).

Figure 85. Change Reporting Time Period Window

Change Reporting Time Period

View results for school year: | 2023-2024 ~

View results for students who were mine on:  07/20/2023 @

Mate: All dates are in Eastern Time Reset To Today

2. From the school year drop-down list, select a school year (Figure 85). This is the year for which you
will view test results.

3. Inthe View results for students who were mine on field, use the calendar tool to select a date, or
enter it in the format mm/dd/yyyy. You will be viewing all the students who were associated with
you and had tested on that date, and only those students.

e To view your current students’ past performance, keep the date set to today.

e To view the past performance of your former students, set the date to a day when those
students were associated with you and had tested.
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4,

Click Save. All reports are now filtered to show only data for the selected school year and date. The
selected date displays in the filter details below the report headings. All other filters are cleared.

Optional: To go back to viewing the latest data, open the Change Reporting Time Period window
again, click Reset To Today in the lower-right corner, then click Save. The date resets and all filters
are cleared. The reporting time period also resets when you log out, but persists when you switch
roles.
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Export and Print Data

You can export or print any data you can view in the Centralized Reporting System. Some can be
exported directly from the Performance on Tests report. You may want to export or print to save a
snapshot of data to consult later, or to share data. Different options will be available depending on the
report you are viewing.

Export or Print a Report You’re Viewing

1. Select the print button from the Features & Tools menu, or, in some reports, from the upper-right
corner. If there are multiple report tables on the page, multiple print buttons will appear.

A print preview page opens (Figure 86).

e Tozoom in on the print preview, use the drop-down list under the Zoom Level (Display only)
section. This setting affects the preview only.

Figure 86. Print Preview Page for a Biology EOC - ICA

Zoom Level (Display only)

HAWAI‘l | Reporting

Normal WV
Score, Performance and Points Earned on Biology EOC - Interim CAT Assessment (ICA) (Pre-Test) of by
Print Options Student and Reporting Category: 2023-2024
Fitered By Rosters: Al Rosters | Test Reasons: Pre-Test
® Print
“eres mager e[ ===
= svtemaces
O Save to PDF B = -
O Save to Excel _— e
) Saveto CSV
a separated i

2. If an aggregate report provides data for individual items, the Report Options section appears. Select
either Summary Only or Summary and Item Scores.

— If you select the latter option, as in Figure 87, the printed report includes data for

the individual assessment items. Printouts of the Student Performance on Test
report always include item data if available.
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Figure 87. Print Preview Page with Summary and Iltem Scores Option Selected for a MATH ICA
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3. To print the report, select the Print radio button. To download it, select Save to PDF, Save to Excel
(XLSX), or Save to CSV (comma-separated values).

e Optional: If a printout or PDF is for a particular student and the report includes items, you
can mark the Include Items and Responses (takes extra time) checkbox. The resulting
report includes the actual items and the student responses.

o If you selected Save to PDF, choose an option from the Page Layout drop-down list that
appears.

Figure 88. Save to PDF: Page Layout Drop-down List Options

Zoom Level (Display only) ¢
HAWAI‘l  Reporting
Statewide Assessments
Normal v
Score, Performance and Points Earned on Blology EOC - Interim CAT Assessment (ICA) (Pre-Test) of . by Student and Reporting Category: 2023-2024
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O Print Student r—
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@ Save to PDF sio

Sute v s
Include Items and

time) ]

Page Layout =2 S
Landscape v (Conges: 5223 e _m
o e Z
Ledger-Wide(17x11) v | P -
O | Ledger(11x17) ” e 0 T o

*The data in this report will be
exported to a comma separated

1 2 o
e Yo P B NossHELsiLer) | NosSHELs Loy | NossaEsiLe
Confirm ‘ Cancel ‘ Humiers and Points Earred 551 H545145 H-L514
—_— L i W
sate w s e

Campar Arsa

4. Click Confirm.

If you saved the report as a PDF, Excel, or CSV, the Secure File Center window appears,
displaying the generated report.
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Export an Assessment Report Directly from the Performance on Tests Report

1. Click .i. to the left of the name of the assessment whose report you wish to export (as in Figure
89).
Figure 89. Teacher View: Performance on Tests Report

#v @HAWAH ‘ Reporting L% Secure File Center @ Help DemoUser, SC v

Select Role > Dashboard Generator > Dashbaard > Performance on Tests Enter Student 1D Q

_
= A My Assessments 131 Features & Tools

Average Score and Performance Distribution, by Assessment: All Rosters, 2023-2024
Fitered 8y Rosters: All Roster | Test Reasons: AllTest Reasons

Assessment Name Test Group Test Grade TestReason © StudentCount © | Average Score Performance Distribution Date Last Taken &
- Interim @
=8 Blocks (1AB) S 2

ge: 10 1 ltems: 1 of1

‘ /A My Students

Most Recent Assessment of All Rosters: 2023-2024
Fitered By Rosters: All Roster | Test Reasons: All Test Reasons
Student Name Student ID Most Recent Assessment DateTaken &

Studer 9999980283 Grade 3 MATH - Geomelry (FIAB) 09/21/2023

9999980282 Grade 3 MATH - Geomelry (FIAB) 09/21/2023

9999080293 Grade 3 MATH - Geometry (FIAB) 09/21/2023

99932002146 Grade 3 MATH - Geametry (FIAB) 09/21/2023
Rows per page: | 10 4 hems: 1 of1

The Export Report window opens. The options in this window vary according to your user role.
2. Select which report to export for the assessment.

e Complex-level users:

— To export the complex test results, mark the Overall Performance of all my Schools radio
button.

— To export school test results (excluding data for individual items), mark the Overall Test &
Reporting Category Performance of all my Students for [School Name] radio button, then
select a school from the drop-down list.

— To export school test results (including data for individual items), mark the Overall Test,
Reporting Category and Item Performance of all my Students for [School Name] radio button,
then select a school from the drop-down list.

Figure 90. Complex-Level User View: Export Report Window
Export Report for Summative Grade 3 MATH

Choose Type of Report
1. @ Overall Performance of all my Schools
O Overall Test, Reporting Category Performance of all students

Select School N

Select Export File Type
2. @®PDF OExcel OCSV

Export Assessment Data
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e School-level users and teachers:

— To export results for all your associated students (excluding data for individual items), mark
the Overall Test, Reporting Category Performance of all students. radio button.

— To export results for all your associated students (including data for individual items), mark
the Overall Test, Reporting Category and Item Performance of all students. radio button.

Figure 91. Teacher View: Export Report Window
Export Report for Test 547498 Math 1/19

Choose Type of Report

1. @ Overall Test, Reporting Category Performance of all students
O Overall Test, Reporting Category and ltem Performance of all students

Select Export File Type
2. ®PDF OExcel OCSV

Export Assessment Data

3. Choose from the PDF, Excel, and CSV formats.
4. Click Export Assessment Data. A confirmation window appears.

Click Yes to export or No to return to the Export Report window. When you’ve exported a file, the
Secure File Center window appears with the generated file available for download.
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Score Iltems

The Centralized Reporting System allows authorized users to score certain items on interim and
Checkpoint (benchmark) tests.

e Some items that require hand scoring arrive in the Centralized Reporting System without any
scores. For example, all short answer items, including field-authored ones, require hand scoring.
If a test contains unscored items, its performance data are excluded from your reports until an
authorized user scores all the unscored items in at least one opportunity of that test.

e Otheritems arrive in the Centralized Reporting System with automated scores suggested by the
machine scoring system. Authorized users can override these scores if necessary. For example,
all full write items have machine-suggested scores that can be overridden.

Score Unscored Items

For a student’s test performance to be reported, you need to enter scores for any hand-scored item
responses on that test.

When you have tests with unscored items, a Tests To Score notification appears in the banner.

Figure 92. Reporting Banner: Tests to Score

HAWA"I Reportmg 8 Secure File Center 0 Help DemoUser, SC v

Statewide Assessments

1. Inthe banner, click Tests To Score.
2. If the Select School page appears, make a selection and click Continue.

3. Onthe scoring Dashboard (Figure 93), click the name of the test you wish to score. The Test Scoring
page appears (Figure 94), displaying a list of students and items awaiting scoring for the selected
test. This table only includes assessments completed by students in your rosters or students in your
test sessions.

Figure 93. Scoring Dashboard

HHR Reporting C3 @ Help HIDOE DEMO v

Scoring Mode b 4

Dashboard

Assessments to score for All Rosters, 2023-2024

Assessment Name Test Reason Stticent el ems ?o Date Last Taken
Count Score Submit
I G6 Math Generated Test 8.1.2023 I Opportunity 4 4 15 1 08/01/2023
Grade 6 MATH - Performance Task - Cell Phone
Plan (IAB) Pre-Test 1 1 0 07/19/2023
Grade 5 MATH - Performance Task - Turtle P
Habitat (IAB) Opportunity 1 2 8 0 07/18/2023
Rows per page: 50 3 Items: 1 of 1
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Figure 94. Test Scoring Page

Scoring Mode x

Dashboard > Test Scoring

G6 Math Generated Test 8.1.2023 (Opportunity 4) to score for Kula a'o Hawai'‘i, 2023-2024

Submit Student - Student ID Date Taken Item To Score

Item Numbers and Max Points

5 6 7 8

2pt  3pt | 1pt | 2pt

PT Only, G6 Demo2 8888880206 8/1/2023 2:06:05 PM 0 Score | Score | Score
PT Only, G5 Demo8 9999990511 8/1/2023211:45PM | Score = Score | Score | Score
PT Only, G5 Demo2 9999990504 8/1/20232:10:229 PM | Score = Score | Score | Score
PT Only, G4 Demo2 9999990417 8/1/2023 2:07:35 PM | Score = Score | Score | Score
Rows per page: 10 4 Items: 1 of 1

Submit Score(s)

4. To enter scores for an item response, click the Score link or score number link for the item in the
required student’s row. The scoring window opens to the Item & Score tab.

5. Optional: You can open the Rubric & Resources tab (Figure 95) to review the item’s scoring rubric
and any other available resources, such as an exemplar and training guide for scoring the item.

Figure 95. Item View Window: Rubric & Resources Tab

CA-CIA Grade 8 ELA
| < mem2s | Student  LAST2011, First2011 5
A Details
Topic Writing and Language Content Alignment Domain: W: Writing Standards
Standards Cluster: WiB.TTP. Text Types and Purposes

Standard: WIS TTPIELA.8.21a: Write informative/explanatory texts to examine a topic and convey ideas, concepts, and
Iinformation through the selection, ceganization, and analysis of relevant content. Introduce a topic clearly, préviewing what is to
follow; organize ideas, concepts, and information into broader categories; Include formatting (e.g., headings), graphics (e.g.,
charts o¢ tables), and multimedia when useful to 2d comprehension

A Rubric

of Purpose/ and
The response Is fully sustained and consistently and purposefully focused:

« controlling idea or main idea of a topic Is focused, clearly stated, and strongly maintained
« controlling ides or main ides of & topic is introduced and communicated clearly within the purpose, sudience, and task

The response has & clear and effective ceganizational structure creating unity and completeness:

6. On the Item & Score tab (Figure 96), click the edit button /" inthe Scoring Criteria table at the top
of the window.

7. Review the student’s entered response and do one of the following:
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10.

11.

e [f the student’s response is scorable, select the appropriate score from the drop-down menu
in the Points Earned column.

e |[f the student’s response cannot be scored for any reason, select the appropriate condition
code from the drop-down in the Condition Code column. For more information about
condition codes, refer to Table 10. Condition Codes.

Figure 96. Item View Window: Item & Score Tab

G6 Math Generated Test 8.1.2023 ’
|
Student:  PT Only, G6 Demo2 : >
| Current Item: 8 Score: Score /2 Condition Code: None Rubric & Resources
Scoring Criteria Max Points Points Earned Condition Code

Correct Answer 2pt Not Scored None

Scoring Note

User Date Note

+ Add Note

student setting(s)

q 5l Gl
TURTLE HABITAT Xall vl RvAlIES

Your teacher announces that vour clag glEI=) “ (=~

In some cases, the Rubric & Resources tab will refer to related items on the test, and scoring of this
item will depend in part on the student's responses to those items. The related items can be viewed
in the Item & Score tab under numbered sub-tabs, which you can find directly below the student
setting(s) toggle.

If the item has multiple scoring criteria, repeat step 7 for each criterion.

e When assigning condition codes to multiple scoring criteria, note that some related criteria
may require the codes to be the same.
Click Save.
Optional: If you wish to provide an explanation for the given score(s) or condition code(s), click Add

Note in the Scoring Note section, then enter your comment and click Save. All notes will be deleted
when scores are submitted, as described in Submit Scored Test Opportunities for Processing.

To continue scoring items, do one of the following:

e To view another unscored item for the same student, use the buttons labeled with the
previous and next item numbers at the upper corners of the scoring window.

e To view the same unscored item for another student, click the up or down arrows on the

right side of the Student field ! Demo Student | at the top of the window.
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e To return to the Scoring Mode window and select another item manually, close the Item
View window using the close button at the upper-right corner.

12. Repeat these steps until you have entered scores for all the unscored items for the test.

13. Optional: If you need to change the entered score for an item response, you can select the score link
for that item on the Test Scoring page and repeat these steps.

Once you have entered scores for all the unscored items in a test opportunity, you may submit that
opportunity for processing.

Note that for some items, two Scoring Criteria tables appear, with the top one allowing you to set scores
and the bottom one displaying transformed scores (Figure 97). When you set a score, the new scores are
automatically transformed, and the transformed scores are what will appear in reports. You will need to
refresh or navigate away from the item before you can view the transformed scores, and there may be a
delay before they appear.

Figure 97. Item View Window: Item & Score Tab: Second Scoring Criteria Table with Transformed Scores

Transformed Points Earned and Condition Codes

Scoring Criteria Max Points | Points Earned Condition Code
Conventions 2 2 None

Organization, Purpose

Evidence and Elaboration Condition Code Selected Off Purpose

Overall 6 2 None

Full write ifems are scored using three dimensions: Conventions. Evidence/Elaboralion and Oraanization/Purnose for a fotal of ten points. For test SCOMNQ DUDOSES,

To return to reports, click the close button at the upper-right corner.

Change the Selected School

Scoring mode allows you to score the item responses for only one school’s test opportunities at a time.
If you are associated with multiple schools, you may change the selected school in order to score the
test opportunities from other schools.

1. To change the selected school, click Change School in the top-right corner of the Dashboard. The
Select School page appears.

Figure 98. Select School Page

Select School

Please select the School you wish to use.

Teacher 14 @ School: Demo inst 9999 v

2. From the Teacher drop-down menu, select the school whose student responses you wish to score.

3. Click Continue. The Dashboard page appears, displaying the tests available for the selected school.
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Submit Scored Test Opportunities for Processing

In order for a test opportunity’s scores to be reported, you will need to submit that opportunity for
processing. You may only submit an opportunity once you have entered scores or condition codes for
every hand-scored item on the test.

1. To submit scored opportunities for processing, navigate to the Test Scoring page (Figure 99) and
mark the checkbox in the Submit column for each opportunity you wish to submit.

e You can mark the checkbox at the top of the Submit column to select all fully scored
opportunities at once.
Figure 99. Test Scoring Page: Submitting an Opportunity

Dashboard 3 Test Scoring

Change School
INTERIM: HS-ELA-IAB-PTExplanatory (School/District Conversation) to score for Demo inst 9999, -
2022-2023
| Submit Student » StudentID Date Taken Items to Score
Item Numbers and Max Points
1 2 3
2pt 2pt 6pt
LAST, FIRST WAMIQAIE — 2/6/2023 3:08:48 PM 0 0 2
LAST, FIRST WAMIQASE  6/14/2023 121446 PM  Score Score o[
!IScore is machine scored, and should be checked.
Rows per page: 16 2 ltems: 1 | ofl

Submit Score(s)

2. Click Submit Score(s) in the bottom-left corner of the page.

3. Inthe confirmation window that pops up, click Continue. The selected opportunities will be
submitted for processing and reporting and removed from scoring. Any scoring notes will be
deleted.

4. To return to reports, click the close button at the upper-right corner. You can still modify the item
scores on that test directly from the reports by following the procedure in the next section, Modify
Scores for Items in Reports.
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Modify Scores for Items in Reports

You can modify scores for some items directly from the Item View window that opens from a report.

Reports display a pencil icon £ in the column header for each item with a modifiable score (as in
Figure 100). When a machine-suggested score has a low confidence level, or when a condition code of

Non-Specific or Uninterpretable Language has been assigned by machine, & displays next to the score.

It is highly recommended that you review items flagged with this icon.

Figure 100. School Performance on Test: Performance by Student Tab with Expanded Reporting Category

Select Role > Dashboard Generator > Dashboard > Performance on Tests > School Performance on Test Enter Student ID Q
= $3% Features & Tools
=k or ince b Performance by Student 2ae
(@) Score, Performance and Points Earned on Grade 7 ELA - Brief Writes (1AB) (Fall) of All Rosters, by Student and Reporting Category: Kula a'c Hawai'i, 2023-
ey
Stardurcs | 2024
Filtered By Rosters: All Roster | TestReasons:Fall | StandardsKeys =
= =
= 2
8 B
= Item Numbers, Max Points and Points Earned
: 2
Performance
| 1] 22| se| se] se| se]
2pt 2pt 2pt 2pt 2pt 2pt
State n/a n/a n/a n/a n/a n/a n/a
Complex Area i, 100% 0 0 2 0 0 0
Court 1
(i}
Complex Percent 100% 0 0 2 0 0 0
Court 1
o
School P J00% 0 0 2 0 0 0
Court 1
Demo, Student 9998090937 At/Near Standard 0 oA 2 oA oA oA
Scores of items marked with @ canbereviewed. M You should review this score
Rows per page: 10 1 tems: 1 of 1

1. On a report with modifiable scores, click the item score link in the student’s row of the report. The
Item View window opens.

2. Optional: You can open the Rubric & Resources tab (Figure 95) to review the item’s scoring rubric
and any other available resources, such as an exemplar and training guide for scoring the item.
3. Onthe Item & Score tab (Figure 96), review the student’s entered response and click &' in the

Scoring Criteria table at the top of the window. The Points Earned and Condition Code columns
become editable.

4. Do one of the following:

e To enter a score for the response, select a numerical score from the Points Earned drop-
down list.

e To assign a condition code to the response, select one from the Condition Code drop-down

list.
5. If the item has multiple scoring criteria, repeat step 4 for each criterion.
6. Click Save.
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7. Optional: If you wish to provide an explanation for why you chose the given score or condition code,
click Add Note in the Scoring Note section, then enter your comment and click Save. Any notes will
be deleted when scores are processed.

8. To continue modifying scores, do one of the following:

e To view another unscored item for the same student, use the buttons labeled with the
previous and next item numbers at the upper corners of the scoring window.

e To view the same unscored item for another student, click the up or down arrows on the

right side of the Student field ! Demo Student | at the top of the window.

The performance data in the test results update automatically when you close the Item View window.

Note that for some items, two Scoring Criteria tables appear, with the top one having modifiable scores
and the bottom one displaying transformed scores, as in Figure 101. When you modify a score, the new
scores are automatically transformed, and the transformed scores are what will appear in reports. You
will need to refresh or navigate away from the item or the report before you can view the transformed
scores, and there may be a delay before they appear.

Figure 101. Item View Window: Item & Score Tab: Second Scoring Criteria Table with Transformed Scores
Transformed Points Earned and Condition Codes
Scoring Criteria Max Points = Points Earned Condition Code
Conventions 2 2 None

Organization, Purpose

Evidence and Elaboration Condition Code Selected Off Purpose

Overall 6 2 None

Fuil write ifems are scored using three dimensions: Conventions. Evidence/Elaboralion and Oraanization/Purpose for a fotal of ten points. For test SCOMNG DUDOSES,
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Appendix
Appendix sections are alphabetized for your convenience.

C

Class (Roster) Management

Classes (rosters) are groups of students. Each user-defined class is associated with a teacher. Each is also
associated with a single administrative year. They typically represent entire classrooms in lower grades,
or individual classroom periods in upper grades. They can also represent any group that is meaningful to
users. A student may belong to more than one class.

Teachers, school-level users, and complex-level users can add, edit, and delete user-defined classes
(rosters). Classes are a great way to organize students, allow teachers to view their students’
performance, and allow other users to compare the performance of different classes. Changes to rosters
may take a few minutes to appear in reports.

When creating classes, follow the guidelines below:

e Classes should ideally include about 25-30 students. If a class is too large or too small, it may affect
the credibility and usefulness of the data available in reports.

e When naming classes, a clear and consistent naming convention should be used that indicates the
grade, class name, teacher, and/or period as applicable. For example, an elementary school class
may be named “Gr3Jones23-24" and a secondary school class may be named
“AikenPeriod3Eng9A23-24".

A few restrictions to be aware of when creating rosters:
e Each user-defined class can only be associated with one school.

e You can only add students who are enrolled in the school or complex associated with your user
account.

e Only 500 active students can be included in one class.

Please see the HSAP TIDE User Guide for detailed instructions on how to add, edit, and delete classes
(rosters) in the TIDE system. The HSAP TIDE User Guide is available on the AlohaHSAP.org portal website.
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Condition Codes

Table 10 provides an overview of the various condition codes that may be entered for a machine- or
hand-scored item when a traditional score cannot be entered for the student’s response.

Table 10. Condition Codes

Source Condition Description
of Code Code
Human Blank e The student did not enter a response.
Human Insufficient Text ¢ The student has not provided a meaningful response. Some
examples:

= Random keystrokes
= Undecipherable text
= “] hate this test”

= “| don’t know”, “IDK”
= ‘I don’t care”

= “l like pizza!” (in response to a reading passage about
helicopters)

= Response consisting entirely of profanity

o For ELA Full Writes, use the “Insufficient Text” code for responses
described above and also if

= The student’s original work is insufficient to make a
determination whether the student is able to organize, cite
evidence/elaborate, and use conventions as defined in the
rubrics.

= The response is too brief to make a determination regarding
whether it is on purpose or on topic.

Human Non-Scorable o ELAl/literacy: Language other than English.
Language e Mathematics: Language other than English or Spanish.
Human Off Purpose e For ELA Full Writes only:

= A writing sample will be judged off purpose when the student
has clearly not written to the purpose designated in the task.

= An off-purpose response addresses the topic of the task but not
the purpose of the task.

= Note that students may use narrative techniques in an
explanatory essay or use argumentative/persuasive techniques
to explain, for example, and still be on purpose.

= Off-purpose responses are generally developed responses
(essays, poems, etc.) clearly not written to the designated
purpose.
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Source
of Code

Human

Machine

Machine

Machine

Machine

Machine

Machine

Machine

Machine

Condition
Code

Off Topic

Blank

Insufficient Text
(Duplicated Text)

Insufficient Text
(Too Few Words)

Insufficient Text
(Copied Text
from the
Prompt)

Insufficient Text
(Refused to
Answer)

Non-Specific

Non-Scorable
Language
(Spanish
Response)

Non-Scorable
Language
(Uninterpretable
Language)

Description

For ELA Full Writes only:

= A writing sample will be judged off topic when the response is
unrelated to the task or the sources or shows no evidence that
the student has read the task or the sources (especially for
informational/explanatory and opinion/argumentative).

= Off-topic responses are generally substantial responses.

The student did not enter a response.

The response contains a significant amount of text repeated over
and over.

The response contains too few words to be considered a valid
attempt.

The response is largely composed of text copied from the prompt.

The response is a refusal to respond, in a form such as “idk” or I
don’t know.”

This condition code is assigned to machine-scored responses
when TDS identifies that the response requires a condition code
but cannot determine which specific condition code it requires.

The response is in Spanish.

The response is in a language other than English or Spanish.
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H

Handscoring for Performance Tasks

The following table indicates how many items at each grade level for ELA and Math that require

handscoring:

Table 11. Handscoring ELA and Math Items

Grade # of ICA ELA # of IAB ELA # of ICA Math # of IAB Math
Handscored Items | Handscored Items Handscored Items | Handscored Items
3 n/a 1 (Readir.rg n/a 4 (PT Only)
Informational Text)
4 n/a n/a n/a 4 (PT Only)
5 n/a n/a n/a 4 (PT Only)
6 n/a n/a n/a 2 (PT Only)
7 n/a n/a n/a 2 (PT Only)
8 n/a n/a n/a 2 (PT Only)
9 n/a n/a n/a n/a
10 n/a n/a n/a n/a
11 n/a n/a n/a n/a
Help

The Centralized Reporting System includes an online user guide.

Access the Online User Guide

In the banner, click Help. The guide opens in a pop-up window, showing the help page specific to the
page you’re on. For example, if you click Help while on the dashboard, the Overview of the Dashboard
page appears.
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M
Multiple Test Opportunities

Sometimes interim test results will include multiple rows for the same student.

When a student completes multiple test opportunities for a single assessment, as in Figure 102, reports
display a row of data for each opportunity. A clock icon appears next to the most recent
opportunity. Previous opportunities are marked with numbers (1}, starting from the earliest test taken.
An asterisk icon indicates that an opportunity is not included in calculations of average scores or

performance distributions.

Figure 102. Roster Performance on Test Report

Selecl Role * Dushtoad Geneater > [ashtons * Perfocsance on Testy  Disirict Performance oo Test * Schocl Prrforsance on Test » Roster Perfosmence on Tl o,
A
E‘E Scof. Performance and Poirs Eamed on Grads 5 ELA - Performance Tesk - Whales (LAB) (Test One] of [siudents not in sy rester). by Siudent and Reponting Category: 20277073 5B Fauturis A Took:
Fiws | Py Eohest A Sowon | Tewl Besse: TeikGne | Bl Keys S -
@ e e o I o
toaiaia ] ] M) Barribairs, M Pt 8 ot [ammad
; 1 [ i 3 L4 4 L4
Pertomance
soEzsswss @ AOEIHEW S (] SCRISAWE [] TWASENTE o
® 1 2pt ]
Rue e
[ le
Diw a— - L 187 o
[ | &
PP P = : 2 L
L]
iy Ehudenits Fr = ¥ 2 L]
[Cema. KATE A Asibe Standard
1 1A AN Slandard 2 d 2 a 1)
Soom of emmared e . cambereeed. Ml Yow nhont e e ncone
Fmema ioel2 )

Most Recent Asssssment # Opportunity is not included in calculations of average scores and performancs levals Pt per page: 2

N

Non-Scorable Test Opportunities

The reports in Centralized Reporting do not include data for non-scorable test opportunities. A student’s
test opportunity cannot be scored when it has a test status of “Expired” or “Invalidated”, or when it
includes blank or empty reporting categories (reporting categories without items). If a test opportunity
is non-scorable, a notification A appears below the report for that assessment.

You can click More Info on the notification to view the Students with Other Test Statuses window. This

window lists the students who have non-scorable test opportunities for the given assessment, as well as
the status code and completion date for each.
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P

Performance Data

Depending on the test, a report may display different kinds of performance data:

Score data:

Scale scores.
Raw scores, which may be in the form of percentages or fractions.

Standard error: After an individual student’s score, you may notice a number with “+”
before it. This is the standard error of measurement (SEM). A student’s score is best
interpreted when recognizing that the student’s knowledge and skills fall within a score
range and not just a precise number. As an example, if a student receives a test score of 75
with an SEM of 4, that tells us that the student’s knowledge and skills fall between 71 and
79. For average scores at aggregate levels, the number following “+” is the standard error of
the mean.

Performance level data, which are used for tests with performance levels (also known as
proficiency levels). Performance levels provide qualitative measurements of students’
proficiency in relation to a particular standard or set of standards.

Some aggregate reports include performance distribution bars, as in Figure 103, showing the
percentage and number of students who achieved each performance level.

These bars are color-coded, with three performance levels being coded red-yellow-green, four
being coded red-yellow-green-blue, and five being coded red-yellow-green-blue-purple.

Measures in aggregate reports for adaptive tests may also include Weak or Strong?, Proficient?,
and % Correct.

Percent proficient, also shown in some aggregate reports (Figure 103), represents the total
percentage of students who achieved proficiency. It typically includes those who fell into the
top one to three performance levels.

Figure 103. District Performance on Test Report

ance o0 Tests * District Performance on Test Q
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bupgesds - v @
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In a report, click the more information button @ in the score or Performance Distribution columns.

A legend appears (Figure 104), explaining what the scores or performance levels indicate.
Figure 104. My Students’ Performance on Test Report with Expanded Performance Distribution Legend

v @H

Select Role > Dashboard Generator > Dashboard > Performance on Tests > My Students’ Test Enter Student ID Q

-
— — i
fr | | performance by Roster | Performance by student 5 eaixes EToots

m Average Score, Performance Distribution and Average Points Eamned on Grade 10 MATH - Interim CAT Assessment (ICA) (Pre-Test), by Roster and Reporting Category: 2023-
suncarss | 2024
Filterea By Rosters: All Roster | Test Reasons:Pre-Test | Standards Keys | [l

Al‘l | Reporting Ca SecureFile Center @ Help ~ DemoUser, TA v

e+ o I ¢ 0 © o o
r AR o
g 2/ 2/8 8|3
8 ; ] g g [EE
i 043 3|3
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Complex [ ctevel1 (2118-2532): 0%
The student has not met the achievement standard and needs substantial
improvement to demonstrate the knowledge and skills in mathematics
needed for likely success in entry-level credit-bearing college coursework "
school %
after high school
[T stevel 2 (2533-2613):
: The student has nearly met the achievement standard and may require :
My Siudents further development to demonstrate the knowledge and skills in o%
mathematics needed for fikely success in entry-level credit-bearing college
coursework after high school
HIDOE UAT Roster (2) 23-24 [ Level 3 2614-2696): 0%
The student has met the achievement standard and demonstrates progress
toward mastery of the knowledge and skills in mathematics needed for
fikely success in entry-level creditbearing college coursework after T [ - 2 | i
completing high school coursework WS per pag
[ sstevel 4 (2697-3085):
The student has exceeded the achievement standard and demonstrates the
knowledge and skills in mathematics needed for ikely success in entry-level
credit-bearing college coursework after high school

You will find similar buttons @ in reports throughout the Centralized Reporting System.

R

Report Tables
Sort a Table

1. To sort by descending order, click the header of the column you wish to sort by. The bottom arrow
in the header is shaded darker » when the column is sorted in descending order.

2. To sort by ascending order, click the column header again. The top arrow in the header is shaded
darker * when the column is sorted in ascending order.

Specify the Number of Rows Displayed

In the Rows per page field below a table, enter the number of rows you want the table to display per
page. Your specifications persist for each table.

You can click the arrow buttons in this field to increase or decrease the number of rows displayed in
increments of one.
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View Additional Table Rows

e To move to the next and previous pages in a table, click the arrow buttons ) (
at the lower-right corner of the table.

e To jump to a specific table page, enter the page number in the field 1 5tthe
lower-right corner of the table.

View Additional Table Columns

e To scroll the table to the right or left, click the arrow buttons @ @ on the right and left

sides of the table. Alternatively, click and drag the horizontal scrollbar at the bottom of the
table.

e |f atable contains expandable and collapsible accordion sections, you can click the section bars
to expand and collapse them.

Expand All Accordion Sections in a Table

If you're navigating the page by tabbing through it, you may want to expand all the expandable
accordion sections of a table at once. This feature, which is available in most test results, will make the
table accessible to a screen reader.

1. Navigate to the table by tabbing through the page in your browser. When the “Load Accessible
Table” message appears, press the Enter key. All the accordion sections expand.

2. Optional: To collapse the sections again, navigate back to the table. When the “Hide Accessible
Table” message appears, press the Enter key. All the accordion sections collapse, except the Total
section.

S

Secure File Center

The Centralized Reporting System allows you to access a Secure File Center that is integrated with other
online assessment systems, such as TIDE, and accessible from your portal. The Secure File Center serves
as a central repository for secure documents uploaded by administrators (such as state personnel) or
shared between users, files exported by users, and hotline alerts.

Each user’s Secure File Center is personal to them and not shared among other users. Users can easily
manage the files in their Secure File Centers. The files are categorized into different tabs to allow users
to view non-archived and archived files. Users can also search for files by keyword. Files are listed in the
order in which they were created. The file creation and file expiration dates appear, if applicable, and
the number of days remaining until a file expires is also displayed. Users can archive or delete files as
needed. Users can also share files by sending them to other users’ Secure File Centers.

Access and Manage Files in the Secure File Center

The files in the Secure File Center are listed in the order in which they were created. The file creation
and file expiration dates appear, if applicable. The number of days remaining until a file expires is also
displayed next to a file. By default, exported files are available for 30 days while secure documents are
available for the period specified by the HIDOE. You can access the Secure File Center from any page in
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Centralized Reporting to either download the file or archive the file. You can also delete the files you
have exported, but not files added by admin users.

1. Inthe banner, click Secure File Center. The Secure File Center window appears (Figure 105). By
default, the Secure File Center displays the View Documents tab.

Figure 105. Secure File Center Window: View Documents Tab: Recent Sub-Tab

Secure File Center

|
etiliedall

Recent  Archived
f 3 Searc

Reporting - KulaaoHawaii_StudentISRs_163153261 09/12/2023 10/112/2023
PM zip Reporting 10:31 AM 10:31 AM

A Custom Labels

- KulaaoHawaii_Student/SRs_163005768 00/12/2023 10/12/2023 ﬁ
PM.zip Reporting 10:30 AM 10:30 AM

View | 20 v ‘ ‘

2. Choose either of the available tabs (Figure 105):
e Recent: Displays all files except those that have been archived.
e Archived: Displays files that have been archived.
Optional: To filter the files displayed, enter a search term in the text box in the upper-right corner.
Optional: To hide or display system labels, click the System Labels toggle.
Optional: To hide files with a particular system label, clear the checkbox for that label.
Optional: To hide or display custom labels, click the Custom Labels toggle.

Optional: To hide files with a particular custom label, clear the checkbox for that label.

© N o 0o b~ W

Optional: Do one of the following:

e To download a file, click the name of the file.

e To add a new custom label or apply an existing custom label, select .

To apply a new custom label, mark the checkbox, enter a new custom label in the text box, and
select Save New Label.

To apply an existing custom label, mark the checkbox, enter an existing custom label in the text box,
and select Apply Label.

e To archive afile, select . To unarchive a file from the Archived tab, select @

e To delete afile, select D Files exported to the Secure File Center or archived can be
deleted. However, secure documents uploaded to the Secure File Center by admin users
cannot be deleted.
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Send Files to Other Users’ Secure File Centers

1. From the banner, select Secure File Center. The Secure File Center page appears. By default, the
View Documents tab displays.

2. Select the Send Files tab. The Send Files page appears (Figure 106).
3. Inthe Select Recipients field, do one of the following:
e Select Role to send a file or files to a group of users by user role.
e Select Email to send a file or files to a single recipient by email address.
e [f you select Email, skip to step 7.
Figure 106. Secure File Center Window: Send Files Tab

Secure File Center

‘ Secure File Center [0 View Documents [ESEESEULRZIE -

Select Recipients

ORrole O Email

Select Role(s)

O stateroles O District roles O School roles

v Select Organization(s)

Add File

Browse

0 of 10 documents

* By clicking Send, you agree that Cambium Assessment cannot be held liable for data shared as a result of sending these files.

4. Inthe Select Role(s) field, select the role group to which you want to send a file or files. A drop-down
list appears.

5. From the drop-down list, select the role(s) to which you want to send a file or files. You can choose
Select all to send a file or files to all roles in the selected role group.

6. From the Select Organization(s) drop-down lists, select organizations that will receive the file(s) you
send. These drop-down lists adhere to the user role hierarchy. For example, district-level users will
be able to filter at their role level and below.

7. If you selected Role in step 3, skip this step. If you selected Email in step 3, enter the email address
of the recipient to whom you wish to send a file or files.

8. To select a file or files to send, in the Add File field, select Browse. A file browser appears.
9. Select the file(s) you wish to send.

10. Select Send.
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Files display in the Secure File Center after you send them.

T
Test Resources

Some test results in the Centralized Reporting System include supplementary information that you can
access, such as resources provided for the assessment in Tools for Teachers.

If additional assessment information is available, click Get Instructional Resources in the Features &
Tools menu.

A window opens (Figure 107), displaying resource links that either download or open in a new browser
tab or window.

Figure 107. Test Resources Window

Test Rosources [ ]

Test Resources for Grade 10 MATH CAT (ICA)

Resource Description

£d

U

User Role Change
If your account is associated with multiple user roles or institutions, you can switch between them. The
following instructions do not apply to switching schools for hand scoring purposes.
1. From the banner menu, select Change Role. (Alternatively, click the Select Role link in the path at
the upper-left corner.) The Change Role window appears.
2. From the Role drop-down list, select the desired role and institution (entity name) combination.
3. Click Continue. The window closes and the Dashboard Generator page appears.
User Support
For additional information and assistance in using the Centralized Reporting System, contact the HSAP
Helpdesk.
The Helpdesk is open Monday—Friday from 7:30 a.m. to 4:00 p.m. Hawaiian Standard Time (except
holidays or as otherwise indicated on the HSAP portal).
HSAP Helpdesk
Toll-Free Phone Support: 1-866-648-3712
Email Support: hsaphelpdesk@cambiumassessment.com
Please provide the Helpdesk with a detailed description of your problem, as well as the following:
o If the issue pertains to a student, provide the student's SSID and associated complex or school.
Do not provide the student’s name.
e If the issue pertains to a Test Information Distribution Engine (TIDE) user, provide the user’s full
name and email address.
e Any error messages and codes that appeared, if applicable.
e QOperating system and browser information, including version numbers (for example, Windows
11 (23h1) and Firefox 113 or macOS 13.3 and Safari 16).
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Change Log

Location Change Date
View Data from a Previous Point in Time | Clarification on how the date setting works. 02/26/2024
Score Items Clarification on scoring notes. 02/26/2024
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